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Preface 
This preface contains the following topics:
• “About this guide” on page vi
• “Accessing Agilent Automation Solutions user information” on page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide contains the safety guidelines and the installation, setup, operation, and 
maintenance procedures for the PlateLoc Thermal Microplate Sealer. This edition 
documents the PlateLoc color touchscreen. 
Note: If your device has a black-and-white touchscreen, see the previous edition of the 
PlateLoc Thermal Microplate Sealer User Guide.
This guide does not provide instructions for the VWorks software or third-party 
software. For more information about these topics, see the relevant user guides. 

Software and firmware versions

This guide documents the following:
PlateLoc firmware version 6.2.0
PlateLoc Diagnostics version 13.1.1.

What is new in this edition

This revision documents the following updates to firmware version 6.0.2:

Job role Responsibilities

Installer Unpacks, installs, and tests the device before it is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, or 
technician

• Manages the automation system that contains the device
• Develops the applications that are run on the system
• Develops training materials and standard operating 

procedures for operators

Operator Performs the daily production work on the device and solves 
routine problems.

Feature See …

New Seal Clearing Mode “Clearing jammed seal” on page 92

Updated Vacuum Readings display “Viewing the vacuum readings” on 
page 91

Updated Settings pages “Settings pages” on page 112 and 
throughout this guide
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Related guides

Use this guide in conjunction with the following:
• Automation Solutions Products General Safety Guide. Provides general safety 

information and describes potential safety hazards that you might encounter when 
using Automation Solutions products. A copy of this safety guide is included with 
your shipment.

• PlateLoc Seal-Loading Card. Functions as a seal-loading accessory and provides 
seal-loading instructions. The printed card (part number G5402-90002) is included 
with the PlateLoc Sealer.

• PlateLoc Thermal Microplate Sealer Quick Start Guide. Provides safety guidelines 
and procedures for starting up the device and sealing microplates.

• PlateLoc Sealer ActiveX version 13.0 User Guide. Describes the ActiveX controls for 
the PlateLoc.

• PlateLoc Thermal Plate Sealer Seal Selection Guide. Provides guidelines on the 
parameter settings for various types of microplates and seal material.

• VWorks Automation Control Setup Guide. Explains how to define labware and 
labware classes, liquid classes, and pipetting techniques, and how to track and 
manage labware in storage.

• VWorks Automation Control User Guide. Explains how to create protocols, and set 
task parameters for each device in the system.

If the PlateLoc Sealer is a device in a third-party system, see the relevant third-party 
system guides.

Related information

Updated Preset page to include 
recommended settings for different types of 
seal based on the microplate type 

“Selecting and editing a saved 
method (touchscreen)” on page 75

Feature See …

For more information about... See...

How to access different formats 
of this user guide

“Accessing Agilent Automation Solutions user 
information” on page viii

Reporting problems “Reporting problems” on page 107
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Accessing Agilent Automation Solutions user information

About this topic

This topic describes the different formats of user information and explains how to 
access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following locations:
• Knowledge base. The help system that contains information about all the 

Automation Solutions products is available from the Help menu within the VWorks 
software. 

• PDF files. The PDF files of the user guides are installed with the VWorks software 
and are on the software CD that is supplied with the product. A PDF viewer is 
required to open a user guide in PDF format. You can download a free PDF viewer 
from the internet. For information about using PDF documents, see the user 
documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the latest 
version of any PDF file from the Agilent website at www.agilent.com/chem/askb. 

Accessing safety information

Safety information for the Agilent Automation Solutions devices appears in the 
Automation Solutions Products General Safety Guide and in the corresponding device 
safety guide or user guide.
You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as Microsoft 
Internet Explorer and Mozilla Firefox.
Note: If you want to use Internet Explorer to display the topics, you might have to allow 
local files to run active content (scripts and ActiveX controls). To do this, in Internet 
Explorer, open the Internet Options dialog box. Click the Advanced tab, locate the 
Security section, and select Allow active content to run in files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.
• From the Windows desktop, do one of the following:

– Windows 10. Select Start > All Apps > Agilent Technologies > VWorks Knowledge 
Base.

– Windows 7. Select Start > All Programs > Agilent Technologies > VVWorks > User 
Guides > VWorks Knowledge Base.

https://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . The pointer 

changes to . Notice that the different icons or areas are highlighted as you 
move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:
• Contents. Lists all the books and the table of contents of the books.
• Index. Displays the index entries of all of the books.
• Search. Allows you to search the Knowledge Base (all products) using 

keywords. You can narrow the search by product.
• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or previous 
topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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1 Safety guidelines
This section contains the following topics:
• “General safety information” on page 2
• “Safety and regulatory compliance” on page 2
• “Stopping in an emergency” on page 4
• “Potential hazards” on page 5
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General safety information

Before installing and using the PlateLoc Sealer

Before using the PlateLoc Sealer, make sure that you are properly trained in:
• General laboratory safety
• The correct and safe operation of the PlateLoc Sealer
• The correct and safe operation of lab automation systems or components used in 

combination with the PlateLoc Sealer

General safety precautions

For the general safety precautions, the intended product use statement, and the list of 
safety labels, see the Automation Solutions Products General Safety Guide. 

Related information

Safety and regulatory compliance

Compliance regulations and standards

The PlateLoc Sealer complies with the applicable EU Directives and bears the CE mark. 
See the Declaration of Conformity or Declaration of Incorporation, as applicable, for 
details. The PlateLoc Sealer is designed to comply with the regulations and standards 
listed in the following table. 

For information about... See...

General precautions, intended product 
use statement, and list of safety labels

Automation Solutions Products General 
Safety Guide

Precautions for potential hazards 
specific to the PlateLoc Sealer

“Potential hazards” on page 5

Regulatory Compliance Standard

EMC

European Union EMC Directive 2014/30/EU

IEC 61326-1:2012 / EN 61326-1:2013

Canada ICES/NMB-001:2006

Australia/New Zealand AS/NZS CISPR 11:2011
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Electromagnetic compatibility
If the PlateLoc Sealer causes interference with radio or television reception, which can 
be determined by turning the device off and on, try one or more of the following 
measures:
• Relocate the radio or television antenna.
• Move the device away from the radio or television.
• Plug the device into a different electrical outlet, so that the device and the radio or 

television are on separate electrical circuits.
• Make sure that all peripheral devices are also certified.
• Make sure that appropriate cables are used to connect the device to peripheral 

equipment.
• Consult your equipment dealer, Agilent Technologies, or an experienced technician 

for assistance.
Changes or modifications not expressly approved by Agilent Technologies could void 
the user's authority to operate the equipment.

South Korea EMC Declaration
The following EMC declaration applies to:

1 All models that were registered on or after 7 December 2016, but
2 Not to models included in a product family or series that was registered before 7 

December 2016 (even if the model was added to the product family or series on or 
after 7 December 2016).

EMC declaration for South Korea
This equipment has been evaluated for its suitability for use in a commercial 
environment. When used in a domestic environment, there is a risk of radio 
interference.

RoHS

European Union RoHS Directive2011/65/EU

Safety

European Union Machinery Directive 2006/42/EC

IEC 61010-1:2001 / EN 61010-1:2001
IEC 61010-2-081:2001 / EN 61010-2-081:2002

Canada CAN/CSA-C22.2 No. 61010-1-04
CAN/CSA-C22.2 No. 61010-2-010:04

USA ANSI/UL Std. No. 61010-1:2005

Regulatory Compliance Standard
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Sound emission declaration
Sound pressure: Lp < 70 dB according to EN ISO 779:2010.
Schalldruckpegel: Lp < 70 dB nach EN ISO 779:2010.

Related information

Stopping in an emergency

Emergency stops

To stop in an emergency:
1 Turn off the PlateLoc Sealer by setting the power switch to off ( O ).
2 Turn off the air supply by setting the AIR ON/OFF switch to OFF.

For information about... See...

General precautions, intended product 
use statement, and list of safety labels

Automation Solutions Products General 
Safety Guide

Potential hazards “Potential hazards” on page 5
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Figure PlateLoc power switch and AIR ON/OFF switch (rear view)

If the PlateLoc Sealer is integrated in an automation system, follow the emergency-
stop protocol for that system.

Related information

Potential hazards 

About this topic

This topic contains precautions about potential hazards that are specific to the 
PlateLoc Sealer. In addition, make sure that you understand how to avoid the general 
hazards described in the Automation Solutions Products General Safety Guide.

Chemical hazards

WARNING
To avoid potential injury, do not use chemicals that have low flash points in the 
PlateLoc Sealer. Such chemicals include reagents that are used in radioactive 
scintillation proximity assays (SPAs) and solvents, including alcohols.

00191
PlateLoc
connections

00191
PlateLoc
connections

Lower gripper to load seal

Press to
close gripper

For information about... See...

General safety guidelines Automation Solutions Products General 
Safety Guide

Potential hazards “Potential hazards” on page 5
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High-temperature hazard

WARNING
The hot surfaces in the PlateLoc Sealer can cause a burn injury. Do not touch the 
PlateLoc Sealer or pry open the door while it is in operation. Use care when accessing 
the PlateLoc Sealer interior after the device is warmed up. Do not reach into the 
PlateLoc Sealer when it is warmed up to a high temperature. Do not touch the hot 
plate with your bare hands.

WARNING
A freshly sealed microplate might still be hot from the sealing process. To prevent 
potential injury, use caution when removing a sealed microplate from the PlateLoc 
Sealer.

Moving-parts hazards

The PlateLoc Sealer contains moving parts that can cause injury. Under normal 
operating conditions, the PlateLoc Sealer is designed to protect you from the moving 
parts. The door sensor is designed so that the seal cycle cannot start unless the door is 
closed.

WARNING
Do not disable the door sensor or attempt to access the interior of the device through 
any other openings. Exposure to the moving parts, such as the heated metal plate 
(hot plate) or the seal-cutting blade can cause severe injuries.

Gas hazards

WARNING
Working with open, charged air lines can result in injury. Turn off the compressed air 
line when disconnecting or reconnecting the PlateLoc Sealer. Contact your facilities 
department or Agilent Technical Support with questions about setting up the air line.

WARNING
Gas-Purging PlateLoc only. Argon is an odorless, colorless, and nontoxic gas that can 
cause rapid suffocation by displacing air. Use the Gas-Purging PlateLoc only in a 
well-ventilated lab area. Turn off the argon gas source when the product is not in use.

PlateLoc
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2 Introduction
This chapter contains the following topics:
• “About the PlateLoc Sealer” on page 8 
• “Hardware overview” on page 9
• “Connection panel” on page 12
• “Labware considerations” on page 13
• “Inserts for microplate support” on page 16
• “Seal material” on page 18
• “Software overview” on page 19
• “Workflow for a standalone device” on page 21
• “Workflow for setting up an integrated device” on page 22
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About the PlateLoc Sealer

The PlateLoc Sealer applies a sealing material on top of microplates to seal individual 
wells. Sealing the wells protects the contents from evaporation, condensation, 
oxidation, and cross-contamination during transport or storage. 

Figure PlateLoc Sealer (front view)

Standalone device or integrated in lab automation system

The PlateLoc Sealer can be used as a standalone device or in a robotic lab automation 
system. 
• Standalone device. As a standalone device, you operate the PlateLoc Sealer using 

the built-in touchscreen. You do not need to connect the device to a computer.
Using the PlateLoc Sealer in the standalone mode enables you to manually load 
and seal one microplate at a time (a single seal cycle in one run). 

• Laboratory automation system. As part of a lab automation system, the PlateLoc 
Sealer is a robot-accessible automated microplate sealer that is controlled by the 
lab automation software, such as the VWorks Automation Control software.
Integrated PlateLoc Sealer operation enables you to automate the loading and 
sealing of multiple microplates in one protocol run (multiple seal cycles in one run).

Gas-Purging PlateLoc 

The Gas-Purging PlateLoc uses argon gas to displace air, containing moisture and 
oxygen, in the microplate immediately before the sealing begins. Because argon is inert, 
it does not react with the microplate contents. The microplate contents can be 
protected from hydration and oxidation for up to 24 hours.
Typically used for compound storage applications, the Gas-Purging PlateLoc is best for 
microplate contents that are sensitive to oxidation and moisture (for example, DMSO).

PlateLoc
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Note: For typical polystyrene and polypropylene microplates, the gas-purging effects 
can last up to 24 hours when the microplates are stored at room temperature. The 
effects can last longer if the microplates are stored at lower temperatures.

Related information

Hardware overview

Front features

The following figure shows the front of the PlateLoc Sealer. The table describes the 
components shown in the figure.

Figure PlateLoc Sealer components (front view)

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Hardware overview “Hardware overview” on page 9

PlateLoc

1

2

3

4

5

6

7

8
9
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Rear features

The following figure and table describe the rear features of the PlateLoc Sealer. 

Figure PlateLoc components (rear view)

Item Feature Description

1 Roll of seal The seal material. For details, see “Seal material” on 
page 18.

2 Hubs The structures (together with the axle, not shown) that 
hold the roll of seal and allow the roll to rotate. 

3 Seal-roll 
supports

The structure on which you mount the hubs and axle.

4 Touchscreen The interface that allows you to specify sealing 
parameters, start and stop the seal cycle, and monitor 
the seal cycle for standalone operation.

5 Screen-release 
lever

The control that unlocks the touchscreen so that you can 
tilt or stow the screen.

6 Sealing chamber The area inside the device where microplates are sealed.

7 Plate stage The removable metal platform on which microplates and 
microplate inserts are loaded.

8 Plate-stage 
support

The structure on which you load the plate stage. The 
plate-stage support extends when the door opens and 
retracts when the door closes.

9 Door (opened) The movable structure that opens when the plate stage 
is extended and closes when the plate stage enters the 
chamber.

00191
PlateLoc
connections

00191
PlateLoc
connections

Lower gripper to load seal

1 2 3 4

Press to
close gripper
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Related information

Item Name Description

1 Seal entry slot The narrow opening into which you insert the seal.

2 Open-gripper 
button

The oval button that you push downward when 
inserting the seal into the seal entry slot. Pushing the 
button downward opens the gripping mechanism that 
holds the seal in position.

3 Close-gripper 
button

The silver button that you press to close the seal-
gripping mechanism.

4 Connection panel The area where you connect the power, air tubing, 
argon tubing (gas-purging PlateLoc only), and 
computer. The panel also contains a gauge that allows 
you to verify air flow.
For a detailed description, see “Connection panel” on 
page 12.

For information about... See...

Connection panel details “Connection panel” on page 12

Microplate requirements “Labware considerations” on page 13

Inserts to support warped or flexible 
microplates

“Inserts for microplate support” on page 16

Seal “Seal material” on page 18

Site requirements “Laboratory requirements” on page 25

Workflow for starting up the device 
and sealing microplates

“Workflow for a standalone device” on 
page 21
“Workflow for setting up an integrated 
device” on page 22
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Connection panel

Description

The following figure shows the PlateLoc connection panel. The table describes each 
component on the panel.

Figure PlateLoc connection panel (rear view)

Item Name Description

1 Air flow gauge Indicates the regulated air pressure (MPa) inside the 
PlateLoc Sealer. 

2 Air supply port Connects the air line to a compressed-air source.
The PlateLoc Sealer uses compressed air to move 
pneumatic components, such as opening and closing 
the door, and driving the hot plate down to the 
microplate surface.

3 Argon-input fitting Gas-Purging PlateLoc only. Connects the argon tubing 
to the Gas-Purging PlateLoc. Argon is used to displace 
air in the microplate, thereby removing oxygen and 
moisture.
Note: Argon starts to fill the sealing chamber 
automatically when a seal cycle starts. For safety 
reasons, the argon stops filling the sealing chamber 
automatically just before the seal is applied.

4 Air on/off switch Turns on or off the air flow into the PlateLoc Sealer.

5 Fuse panel Houses the AC inlet fuse.

6 Power switch Turns on ( I ) and off ( O ) the PlateLoc Sealer power.

7 AC power entry Connects the PlateLoc power cord to an AC outlet with 
a grounded circuit. 

8 Serial port (DB-9 
RS-232 9-pin)

Connects the serial cable from the controlling 
computer to the PlateLoc Sealer.
Use this port when installing the PlateLoc Sealer in a 
lab automation system.

1

2

3

4

5

6

7

8

9
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Related information

Labware considerations

Acceptable microplates

The PlateLoc Sealer is designed for labware that comply with the standards ANSI/
SLAS 1-2004 (R2012) through ANSI/SLAS 4-2004 (R2012). 

How microplate features affect sealing parameters

The ideal sealing conditions vary based on factors such as the microplate material and 
design. You should run optimization tests to determine the best sealing parameters to 
use for each microplate type. 

Microplate material
For the best sealing results:
• Use polypropylene microplates because they are the easiest to seal effectively and 

reliably.
• Avoid acrylic microplates because they are not compatible with thermal microplate 

sealing.

9 Service ports For use by Agilent personnel only.

Item Name Description

For information about... See...

Connecting the PlateLoc “Connecting the power source” on page 33
“Connecting and disconnecting the air 
source” on page 34
“Setting up the computer (lab automation 
system only)” on page 39

Site requirements “Laboratory requirements” on page 25

Hardware components “Hardware overview” on page 9

Microplate requirements “Labware considerations” on page 13

Workflow for starting up the device 
and sealing microplates

“Workflow for a standalone device” on 
page 21
“Workflow for setting up an integrated 
device” on page 22



2   Introduction
Labware considerations

14 G5585B PlateLoc Thermal Microplate Sealer User Guide

Microplate design
Microplate design features, such as thickness and geometry, effect the sealing 
conditions. The most compatible microplates have wells with raised chimneys, which 
have flat surfaces at the top, as the following figure shows. These features can 
minimize cross-contamination, reduce evaporation, and minimize condensation. 

Figure Microplate design features (cutaway side view)

The PlateLoc Sealer applies seals using pressure and heat. During the seal cycle, a 
heated metal plate (hot plate) inside the PlateLoc sealing chamber descends and 
presses the seal onto the microplate. The hot plate can sense and automatically adjust 
for variations in microplate height. 
The following figure shows a cutaway side view of a seal being applied to a microplate:

(A) The alignment of the hot plate, the seal, and the microplate before the seal is 
applied. Notice that the microplate has a raised rim around the perimeter that is 
higher than the well chimney height.
(B) The hot plate must fit within the rimmed perimeter of the microplate so that the 
hot plate can make uniform contact with the seal and all sample wells 
simultaneously. 

Figure Applying seal: (1) hot plate, (2) seal, and (3) microplate (cutaway side view)

1 2 3

4
5

Item Description.

1 Raised rim around perimeter of microplate

2 Microplate surface

3 Well chimneys that rise above the microplate surface

4 Microplate skirt

5 Insert that supports the microplate during the sealing process

HOT PLATE

HOT PLATE

1
2

3

A B
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Challenging microplates

Because of the material or design, the following microplates might cause poor seal 
results when used in the PlateLoc Sealer:
• Microplates that have non-binding coatings
• Flexible microplates that tend to bend during sealing 
• Warped microplates or microplates that do not lie flat
• Microplates that lack raised chimneys or have molded branding or legends, such 

as the manufacturer’s name or logo, close to the tops of the wells (close enough so 
that seal touches or covers the imprint)

• Microplates that have tooling marks or manufacturing aids, such as circular 
depressions (sometimes with branching) caused by ejection pins or part of the 
molding process
Note: Gaps or gutters may not only prevent binding of the seal, but may actually 
facilitate cross-contamination of liquid samples.

You should run some sealing tests to determine whether optimal sealing is possible 
with these microplates or if you should use different microplate types. 
If warped microplates are a challenge, or if you experience non-uniformity in seal 
quality, you can use an insert to support the microplate.

Related information

For information about... See...

Types of seal, sealing conditions, and 
compatible types of microplates 

PlateLoc Thermal Microplate Sealer 
Consumables Selection Guide
Go to http://www.agilent.com/en-us/
products/automation-solutions/
microplate-management-robotics/plateloc-
thermal-microplate-sealer

Inserts to support warped or flexible 
microplates

“Inserts for microplate support” on page 16

Seal “Seal material” on page 18

Optimization test guidelines “Optimizing seal quality” on page 83

Site requirements “Laboratory requirements” on page 25

http://www.agilent.com/en-us/products/automation-solutions/microplate-management-robotics/plateloc-thermal-microplate-sealer
http://www.agilent.com/en-us/products/automation-solutions/microplate-management-robotics/plateloc-thermal-microplate-sealer
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Inserts for microplate support

What are inserts

Inserts are pads that support the bottoms of microplates to provide uniform seals. You 
use inserts to support microplates that tend to bend during a seal cycle.

When to use an insert

During the seal cycle, the hot plate inside the sealing chamber descends and presses 
the seal onto the microplate. In a quality seal, the seal material is applied to the 
microplate uniformly. However, the following factors can cause uneven microplate 
sealing:
• Because of the material used, some microplates tend to bend in the high-

temperature environment.
• In some microplate designs, the microplate skirt sits higher or lower than the 

microplate bottom, causing uneven sealing.
The following figure shows a side profile of a microplate. 

Figure Microplate (A) without insert and (B) with insert (cutaway side view)

In this example, the microplate skirt extends lower than the bottom of the wells. 
Depending on the microplate material, such designs can cause non-uniform sealing. 
When the hot plate presses down, the wells at the center of the microplate might bend 
upward or downward (A). This type of microplate requires an insert (B) for support to 
provide uniform sealing of all the wells.
The following figure shows the top view of sealed microplates with non-uniform seals. 
Non-uniform seals can result when the center of the microplate bends upward (A) and 
downward (B) during the seal cycle.

Figure Non-uniform microplate seals: (A) Center too high, (B) Center too low 
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Using inserts to support microplates

The following figure shows the standard inserts that are supplied with the PlateLoc 
Sealer. The table describes each insert.

Figure Standard inserts (90, 180, 235, and 290)

The type of insert you use depends on the microplate material and design. Agilent 
Technologies recommends that you run optimization tests to determine the best insert 
for the microplate you are using. 

Related information

Insert Description Thickness Height above plate 
stage support

Use with microplates that 
require...

90 Metal pad with rubber 
foam padding on the 
microplate-facing side

8.65 mm (0.340 
in)

4 mm (0.2 in) Flexible support

180 Metal pad 4.60 mm (0.180 
in)

0 mm (0 in) Non-flexible support under the 
wells

235 Metal pad 6.00 mm (0.235 
in)

1.4 mm (0.055 in) Non-flexible support under the 
wells

290 Metal pad 7.37 mm (0.290 
in)

2.8 mm (0.11 in) Non-flexible support under the 
wells

For information about... See...

Microplate guidelines “Labware considerations” on page 13

Seal “Seal material” on page 18

Optimization test guidelines “Optimizing seal quality” on page 83

Site requirements “Laboratory requirements” on page 25
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Seal material

Selecting seal material

To ensure optimal seal quality, Agilent Technologies recommends that you run 
optimization tests to determine the best sealing parameters to use for each microplate 
type and application.

CAUTION
Seals from a supplier other than Agilent Technologies might not seal properly in the 
PlateLoc Sealer and can damage the device. Use only Agilent seals with the PlateLoc 
Sealer.

Agilent Technologies offers a variety of seals with different properties, including:
• Clear seals. Allows you to see the contents of the microplate.
• Aluminum seals. Protects light-sensitive samples or compounds in the microplate.
• Peelable seals. Allows you to peel the seal off the microplate in a downstream task.
The type of seal you can use depends on a number of factors, including microplate 
material, design, properties (for example, optical and physical properties), contents 
(samples, reagents, and so forth), application (for example, PCR, DNA sequencing, 
compound storage), and storage duration and conditions.

Related information

For information about... See...

Types of seal, sealing conditions, and 
compatible types of microplates 

PlateLoc Thermal Microplate Sealer 
Consumables Selection Guide
Go to http://www.agilent.com/en-us/
products/automation-solutions/
microplate-management-robotics/plateloc-
thermal-microplate-sealer

Microplate guidelines “Labware considerations” on page 13

Inserts for microplate support “Inserts for microplate support” on page 16

Optimization test guidelines “Optimizing seal quality” on page 83

Site requirements “Laboratory requirements” on page 25

http://www.agilent.com/en-us/products/automation-solutions/microplate-management-robotics/plateloc-thermal-microplate-sealer
http://www.agilent.com/en-us/products/automation-solutions/microplate-management-robotics/plateloc-thermal-microplate-sealer
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Software overview

About this topic

This topic describes the software that you can use to set up and control the PlateLoc 
Sealer in a lab automation system.
Note: If you are using the PlateLoc Sealer as a standalone device, the lab automation 
software is not necessary.

Lab automation requirements

In a lab automation system, you can use a plate-loading robot to automate the sealing 
of multiple microplates. You use the automation control software to set up the 
communication between the system and the PlateLoc device, set up the sealing 
parameters, and control the automation.
You can use either the VWorks software or third-party automation software to operate 
the PlateLoc Sealer in protocol runs. For third-party automation software, you use the 
PlateLoc ActiveX control to permit the software to interface with the device.

VWorks software

The VWorks software enables you to:
• Set up user accounts and privileges. You can set up different user accounts to 

enforce access policies.
• Define labware. Labware definitions describe the labware you will use during 

protocol runs. 
• Create protocols. Protocols determine the sequence of tasks you want to automate 

in a run. For example, you can use a protocol to seal 10 microplates in one protocol 
run.

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, and stop a 
protocol run from the controlling computer.

PlateLoc Diagnostics

The PlateLoc Diagnostics software is a component that you access through the 
VWorks software or the PlateLoc ActiveX control. The PlateLoc Diagnostics software 
enables you to:
• Set up the PlateLoc Sealer for automated operation. The setup requires a device 

profile that specifies the:
– Serial communication connection (COM port) with the controlling computer
– Default sealing parameter values

• Seal individual microplates without running a protocol. 
This is equivalent to running the device from the touchscreen.

• Check the odometer. The odometer indicates the number of sealing cycles the 
device has performed. You can refer to this value for preventive maintenance 
purposes.
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PlateLoc ActiveX control

In an automation system that uses third-party automation control software, you use the 
PlateLoc ActiveX control to permit the software to interface with the PlateLoc Sealer.

Related information

For information about... See...

Workflow for sealing a microplate on 
a standalone PlateLoc Sealer

PlateLoc Thermal Microplate Sealer Quick 
Start
“Workflow for a standalone device” on 
page 21

Workflow for sealing multiple 
microplates in a protocol run

“Workflow for setting up an integrated 
device” on page 22

Setting up the VWorks software VWorks Automation Control Setup Guide

Creating and running VWorks 
protocols

VWorks Automation Control User Guide

PlateLoc ActiveX control PlateLoc Sealer ActiveX version 13.0 User 
Guide
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Workflow for a standalone device 

About this topic

This topic presents the basic steps for setting up and operating the PlateLoc Sealer as 
a standalone device. 
Alternatively, see the PlateLoc Thermal Microplate Sealer Quick Start.

Workflow to set up and operate the device

When optimizing the seal quality, repeat steps 7 through 9.

Related information

Step Procedure See...

1 Prepare the laboratory for the 
installation and install the PlateLoc 
Sealer.

“Installation workflow” on page 24

2 Turn on the PlateLoc Sealer. “Turning on and off the power” on page 42

3 Turn on the air. “Turning on and off the air” on page 43

4 Gas-Purging PlateLoc only. Turn on the 
argon.

“Turning on and turning off the argon (Gas-Purging 
Plateloc only)” on page 45

5 Adjust the touchscreen. • “Tilting or stowing the touchscreen” on page 47
• “Adjusting the touchscreen brightness” on page 49

6 Specify a Sleep Mode for idle times. “Specifying a Sleep Mode” on page 50

7 Load the seal. “Loading and unloading a roll of seal” on page 51

8 Load an insert and a microplate. “Loading an insert and a microplate” on page 70

9 Set the sealing parameters. “Setting the sealing parameters” on page 72

10 Start the seal cycle. “Starting the seal cycle” on page 78

For information about... See...

Microplates and seals “Labware considerations” on page 13

Optimizing seal quality “Optimizing seal quality” on page 83

Workflow for an integrated PlateLoc 
Sealer

“Workflow for setting up an integrated 
device” on page 22
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Workflow for setting up an integrated device

About this topic

Use the following workflow to set up and operate the PlateLoc Sealer in a lab 
automation system. 

Workflow 

Step Procedure See...

1 Prepare the laboratory for installation 
and install the PlateLoc Sealer.

“Installation workflow” on page 24

2 Turn on the PlateLoc Sealer. “Turning on and off the power” on page 42

3 Turn on the air. “Turning on and off the air” on page 43

4 Gas-Purging PlateLoc only. Turn on the 
argon.

“Turning on and turning off the argon (Gas-Purging 
Plateloc only)” on page 45

5 Optional. Adjust the touchscreen. • “Tilting or stowing the touchscreen” on page 47
• “Adjusting the touchscreen brightness” on page 49

6 Specify a Sleep Mode for idle times. “Specifying a Sleep Mode” on page 50

7 Load the seal. “Loading and unloading a roll of seal” on page 51

8 Install the VWorks software, or integrate 
PlateLoc ActiveX control.

One of the following:
• VWorks Automation Control Setup Guide
• PlateLoc Sealer ActiveX version 13.0 User Guide

9 VWorks software only. Start the VWorks 
software and log in.

VWorks Automation Control User Guide

10 VWorks software only. Add the PlateLoc 
device to a device file.

“Creating and editing VWorks device files” on page 59

11 Open PlateLoc Diagnostics. “Opening PlateLoc Diagnostics” on page 62

12 Create a PlateLoc profile and set the 
profile parameters.

“Creating and editing profiles” on page 64

13 Initialize the PlateLoc Sealer. “Initializing the device” on page 67

14 Set the robot teachpoint at the PlateLoc 
Sealer.

Robot user documentation

15 Write and run protocols. One of the following:
• VWorks Automation Control User Guide
• Automation software user documentation
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3 Unpacking and installation
This chapter contains the following topics:
• “Installation workflow” on page 24
• “Laboratory requirements” on page 25
• “Unpacking the PlateLoc Sealer” on page 30
• “Connecting the power source” on page 33
• “Connecting and disconnecting the air source” on page 34
• “Connecting and disconnecting the argon source” on page 36
• “Setting up the computer (lab automation system only)” on page 39
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Installation workflow

Workflow

The following table presents the workflow for unpacking and installing the PlateLoc 
Sealer.

Related information

Step Procedure See...

1 Prepare your lab for the installation. “Laboratory requirements” on 
page 25

2 Unpack the PlateLoc Sealer. “Unpacking the PlateLoc Sealer” 
on page 30

3 Connect the PlateLoc Sealer to the power 
source.

“Connecting the power source” 
on page 33

4 Connect the PlateLoc Sealer to the air 
source.

“Connecting and disconnecting 
the air source” on page 34

5 Gas-Purging PlateLoc only. Connect the 
PlateLoc to the argon source.

“Connecting and disconnecting 
the argon source” on page 36

6 Lab automation systems only. Connect the 
PlateLoc Sealer to the controlling 
computer.

“Setting up the computer (lab 
automation system only)” on 
page 39

7 Lab automation systems only. Install one 
of the following:
• VWorks software
• PlateLoc ActiveX control for third-

party automation software 

Software release notes

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Hardware components “Hardware overview” on page 9

Connection panel “Connection panel” on page 12
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Laboratory requirements

About this topic

This topic describes the site requirements for installing the PlateLoc Sealer.

Laboratory space requirements

When planning the laboratory space for the PlateLoc Sealer, ensure the following:
• Sufficient clearance is available around the PlateLoc Sealer so that you can reach 

the back of the device to turn off the power and air in an emergency.
• The PlateLoc Sealer is within 1.8 m (6 ft) of the electrical outlets.
• The PlateLoc Sealer is within 4.6 m (15 ft) of the air source.
• Gas-Purging PlateLoc only. The PlateLoc Sealer is within 4.6 m (15 ft) of the argon 

source.
• Gas-Purging PlateLoc only. The room is well ventilated.
Lab automation system installation only. Check with the lab automation system 
manufacturer for installation requirements.

Laboratory table or bench

Ensure the following:
• Provide adequate table surface space for the PlateLoc Sealer.
• Make sure the table can support the weight of the PlateLoc Sealer.
• Ensure that the table surface is level.
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PlateLoc dimensions

The weight and dimensions of the PlateLoc Sealer are as follows:

Figure PlateLoc Sealer dimensions with door open and roll of seal (front and side views)

                                                        

Dimension Value

Weight 20.0 kg (45.0 lb)

Width 21.6 cm (8.5 in)

Height (with roll of seal) 58.4 cm (23.0 in)

Depth (with door open and roll of seal) 39.9 cm (15.7 in)

39.9 cm
21.6 cm

58.4 cm
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Compressed air requirements

The PlateLoc Sealer requires the use of oil-free compressed air to move pneumatic 
components inside the device. The oil-free compressed air can be from the following 
sources:
• Centralized source (house)
• Portable pumps

CAUTION
Ensure that the air coming into the PlateLoc Sealer is properly filtered from moisture 
or aerosolized impurities. Significant moisture or impurities in the air line can 
adversely affect the performance and life of the PlateLoc Sealer. Using oil 
compressors can cause oil to leak into the PlateLoc Sealer and void your warranty.

CAUTION
Air pressure greater than 0.69 MPa (100 psi) can damage the PlateLoc Sealer. 
Ensure that the air source meets the requirements for pressure and flow rate.

IMPORTANT
The PlateLoc Sealer will not function properly if the air supply does not meet the 
specified flow rate (cfm) and pressure (psi).

To maintain the desired air supply in the device, the PlateLoc Sealer requires a source 
of air as follows:

Note: The PlateLoc regulates the air internally to 0.62 ±0.01 MPa (90 ±2 psi).

Environmental requirements

The following table provides the PlateLoc environmental requirements.

                                                        

Air source requirement Value

Quality Clean, dry, compressed

Flow rate 70.8 Lpm (2.50 cfm)

Pressure 0.62–0.69 MPa (90–100 psi)

Requirement Value

Ambient temperature 4–40 °C (39–104 °F)

Humidity condition 10–90% RH, non-condensing

Maximum altitude 2000 m

Pollution degree 2

Installation category II
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The PlateLoc Sealer is for indoor use only.
Make sure that the PlateLoc Sealer is located away from the following:
• Heat and air conditioning ducts
• Direct sunlight

Electrical requirements

The PlateLoc electrical requirements are specific to each model. The following table 
provides the requirements for each model.

Mains supply voltage fluctuations are not to exceed ±10% of the nominal supply 
voltage. A combination of low input voltage and low ambient temperature can reduce 
the maximum sealing temperature achievable.

WARNING
To prevent potential personnel injury or death and equipment damage, always 
connect the PlateLoc Sealer to an AC circuit that is properly grounded.

Argon source requirements (Gas-Purging PlateLoc only)

The Gas-Purging PlateLoc typically uses argon to displace air (oxygen and moisture) in 
the microplate. The argon can be from a centralized source (house) or from a cylinder.
To maintain the desired argon supply in the device, make sure the argon meets the 
following requirements.

WARNING
Gas-Purging PlateLoc only. Argon is an odorless, colorless, and nontoxic gas that can 
cause rapid suffocation by displacing air. Use the Gas-Purging PlateLoc only in a 
well-ventilated lab area. Turn off the argon gas source when the product is not in use.

                                                        

Requirement Model

Voltage 100 to 120 V~ 200 to 240 V~

Frequency 50/60 Hz 50/60 Hz

Current (maximum) 4 A 2.5 A 

Fuse 4 A, fast blow, 312 Series, 
3 AG, 250 V

2.5 A, fast blow, 312 Series, 
250 V

Requirement Value

Quality 99.9% pure, welding grade, containing up to 1 ppb water
Note: The water content is more important than the gas grade.

Pressure 0.28 MPa (40 psi)
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Computer requirements

If you are installing the PlateLoc Sealer in a lab automation system, you must connect 
the device to the controlling computer. The computer requirements depend on the lab 
automation software you are using:
• For VWorks software computer requirements, see the VWorks software release 

notes or the VWorks Knowledge Base at www.agilent.com/chem/askb. 
• For third-party automation software requirements, see the user documentation 

supplied with the product.

Operating supplies and accessories

For optimal sealing results, the PlateLoc Sealer requires:
• Compatible microplates. See “Labware considerations” on page 13.
• Microplate inserts, if necessary, depending on the microplate type. See “Inserts for 

microplate support” on page 16.
• Appropriate seal material. See “Seal material” on page 18.

Related information

For information about... See...

Hardware components “Hardware overview” on page 9

Connection panel description “Connection panel” on page 12

https://www.agilent.com/chem/askb
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Unpacking the PlateLoc Sealer

Before you start

WARNING
The PlateLoc Sealer weighs approximately 20 kg (45 lb). Attempting to move the 
device without assistance could cause personal injury. Request assistance and use 
proper lifting techniques when lifting the device.

CAUTION
Packing the PlateLoc Sealer using other materials might damage the device and void 
your warranty. Save the packing materials and shipping container in case you are 
required to move or ship the PlateLoc Sealer. 

Unpacking the PlateLoc Sealer from its shipping container

The PlateLoc Sealer and its components are shipped in the following containers:
• PlateLoc device shipping box
• Seal roll shipping box
• Pneumatics kit (air connection kit)
The country-appropriate power cord, pneumatics kit, and serial cable are shipped 
separately. The air tubing and fittings are included in the pneumatics kit. Depending on 
the configuration of your air supply system, one or more of the provided air fittings may 
be required. If your air system has a different configuration, you must supply your own 
fittings.

To unpack the PlateLoc Sealer and the roll of seal:
1 Open the top of the PlateLoc shipping box.
2 Remove the top inner box and set it aside.
3 Carefully lift the PlateLoc Sealer out of the shipping box. See the following figure, 1.
4 Remove the packing foam on the left and right sides of the device.
5 Remove the PlateLoc Sealer from the plastic bag, and set it carefully on the lab 

bench where you want to install the device.

IMPORTANT
The small block of packing foam must be removed from inside the sealing chamber 
before you can use the PlateLoc. You can try to remove the foam before installing the 
device. Otherwise, you will remove this foam block after you install the device and turn 
on the air for the first time.

6 Open the inner box and remove the components:
a Important Documents envelope
b Thin layer of packing foam
c Hub and axle (figure, 2), plate stage (figure, 3), and plate inserts (figure, 4)

7 Open the separate shipping box and remove the roll of seal (figure, 5) and seal-
loading card (figure, 6). Remove the seal from the plastic bag.
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Figure Components in the shipping boxes

Inspecting the contents

After you unpack the PlateLoc Sealer and seal, ensure that you have the items listed in 
the preceding table.
                                                        

290

235
180

090

PlateLoc

1 2 3

45

6

Item Name Description

1 PlateLoc Sealer The unpacked PlateLoc device.

2 Hubs and axle The mechanism that holds the roll of seal and 
supplies the seal for the PlateLoc Sealer.

3 Plate stage The removable plate stage that sits on the plate 
stage support in the PlateLoc Sealer.

4 Inserts The pads that support the bottoms of microplates 
to provide uniform seals.

5 Roll of seal The plate sealing material.

6 Seal-loading card The card that you use to insert the seal in the 
loading slot when loading a new roll of seal.

7 Air connection kit  
(not shown)

The pneumatics tubing, fittings, and inline shutoff 
valve.

8 Cables (not shown) The country-appropriate power cord and the 
communication cabling.
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Additional components for the Gas-Purging PlateLoc
If you have the Gas-Purging PlateLoc, ensure that you have the argon tubing and fittings 
and the inline shutoff valve.

Missing or damaged items
Inspect the items to make sure you have everything listed. If any of the items are 
missing or defective on arrival, contact Agilent as soon as possible. For your region’s 
contact information, see: https://www.agilent.com/en/contact-us/page

Related information

For information about... See...

Installing the PlateLoc “Installation workflow” on page 24

Safety guidelines “Safety guidelines” on page 1

Hardware components “Hardware overview” on page 9

Connection panel description “Connection panel” on page 12

https://www.agilent.com/en/contact-us/page
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Connecting the power source

Before you start

Ensure the following:
• The voltage supplied to the PlateLoc Sealer meets the specifications. See 

“Electrical requirements” on page 28.
• The PlateLoc Sealer power switch is set to off ( O ).
• You have the supplied country-specific power cord.

Procedure

To connect the power cord:
1 Connect one end of the power cord to the AC power entry on the back of the 

PlateLoc Sealer.
2 Connect the other end of the power cord to an AC outlet with a grounded circuit.

Related information
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For information about... See...

Installing the PlateLoc “Installation workflow” on page 24

Safety guidelines “Safety guidelines” on page 1

Connecting the air source “Connecting and disconnecting the air 
source” on page 34

Connecting to the computer “Setting up the computer (lab automation 
system only)” on page 39
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Connecting and disconnecting the air source

About this topic

Compressed air is used to move pneumatic components inside the PlateLoc Sealer. 
This topic explains how to connect the PlateLoc Sealer to the air source and check the 
connections for leaks before use.

Before you start

WARNING
Working with open, charged air lines can result in injury. Turn off the compressed air 
line when disconnecting or reconnecting the PlateLoc Sealer. Contact your facilities 
department or Agilent Technical Support with questions about setting up the air line.

CAUTION
Ensure that the air coming into the PlateLoc Sealer is properly filtered from moisture 
or aerosolized impurities. Significant moisture or impurities in the air line can 
adversely affect the performance and life of the PlateLoc Sealer. Using oil 
compressors can cause oil to leak into the PlateLoc Sealer and void your warranty.

Ensure the following:
• The air supplied to the PlateLoc Sealer meets the specifications. See “Compressed 

air requirements” on page 27.
• You have the pneumatics kit (supplied). The air tubing and fittings are included in 

the pneumatics kit. Depending on the configuration of your air supply system, one 
or more of the provided air fittings may be required. 
The kit includes an inline shutoff valve, which helps release the air pressure in the 
line when you turn off the air supply to the PlateLoc Sealer.
Note: If your air system has a different configuration, you must supply your own 
fittings.

Connecting the air source

To connect the PlateLoc Sealer to your air source:
1 Turn off the air at the source (house, cylinder, or pump).
2 Attach the following adapter fittings to the air source connection if necessary:

• NPT fitting. If your air source uses a threaded connection, attach the supplied 
1/4-inch or 1/8-in NPT fitting to the connection. The NPT fitting is threaded on 
one end and has a quick-release fitting on the other end.

• Metric fittings adapter. If your lab requires metric fittings at the air source, 
attach the supplied metric adapter fitting to the air source connection. The 
metric adapter fitting has a quick-release fitting on one end.
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3 Connect the air tubing using the inline shutoff valve, as follows:

Figure Inline shutoff valve

Note: The inline shutoff valve releases the air pressure in the air line when 
you turn off the air supply to the PlateLoc Sealer. 

a Connect one length of tubing from the air source (house, cylinder, or pump) to 
the inline shutoff valve (pneumatics kit).

b Connect a second length of tubing from the inline shutoff valve to the quick-
release fitting at the air-input (AIR IN) port on the back of the PlateLoc Sealer.

The following figure shows the air tubing connection on the back of the PlateLoc 
Sealer.

Figure PlateLoc AIR IN port (rear view)

Checking the air connections

To check the air connections:
1 With the air source turned off, gently tug the air tubing at each connection.

If you feel resistance at the connection, the tubing has been properly installed.
2 Turn on the air source.
3 Listen near each connection for hissing sounds that might indicate a leak.

If you hear hissing sounds, turn off the air at the source and on the back of the 
PlateLoc Sealer, check and tighten the connections, and then turn on the air again. 
If the problem persists, contact your facilities department or Agilent Technical 
Support.
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Disconnecting the air source

CAUTION
Pulling the tubing out of the orange quick-release fitting can damage the fitting. To 
disconnect the air tubing, ensure that you use the following procedure.

To disconnect the air tubing from the PlateLoc:
1 Turn off the air at the source (house, cylinder, or pump).
2 Turn off the inline shutoff valve to relieve the air pressure in the line.
3 Turn off the air on the back of the PlateLoc Sealer.
4 Push and hold the locking collar against the fitting, and then gently pull the air 

tubing out.

Figure Close-up view of the quick-release fitting

Note: Alternatively, you can use the SMC Pneumatics tool (TG-2) to aid in this 
task. See the manufacturer’s documentation for use instructions. Contact your 
local SMC parts supplier for ordering details.

Related information

Connecting and disconnecting the argon source 

About this topic

Read this topic only if you have a Gas-Purging PlateLoc. This topic explains how to 
connect the Gas-Purging PlateLoc to the argon source. 

Before you start

WARNING
Argon is an odorless, colorless, and nontoxic gas that can cause rapid suffocation by 
displacing air. Use the Gas-Purging PlateLoc only in a well-ventilated lab area. Turn 
off the argon gas source when the product is not in use.

For information about... See...

Installing the PlateLoc Sealer “Installation workflow” on page 24

Safety guidelines “Safety guidelines” on page 1

Connecting the argon source “Connecting and disconnecting the argon 
source” on page 36



37

3   Unpacking and installation
Connecting and disconnecting the argon source

G5585B PlateLoc Thermal Microplate Sealer User Guide

Ensure that the argon supplied to the Gas-Purging PlateLoc meets the specifications. 
See “Argon source requirements (Gas-Purging PlateLoc only)” on page 28.
Make sure you have the following supplied parts:
• Argon tubing
• NPT or metric adapter fitting
• Inline shutoff valve

Connecting the argon source

To connect the Gas-Purging PlateLoc to your argon source:
1 Turn off the argon source (house or cylinder).
2 Attach the following adapter fittings to the argon source if necessary:

• NPT fitting. If your argon source uses a threaded connection, attach the 
supplied 1/4-inch or 1/8-in NPT fitting to the connection. The NPT fitting is 
threaded on one end and has a quick-release fitting on the other end.

• Metric fittings adapter. If your lab requires metric fittings at the argon source, 
attach the supplied metric adapter fitting to the argon source connection. The 
metric adapter fitting has a quick-release fitting on one end.

3 Connect the argon tubing using the inline shutoff valve, as follows:
a Connect one end of the argon tubing to the argon source, and then connect the 

free end of that tubing to the inline shutoff valve.
b Connect a second length of tubing from the inline shutoff valve to the quick-

release fitting at the argon-input port on the back of the Gas-Purging PlateLoc.
To connect the tubing, push the end of the tubing into the quick disconnect fitting 
at the argon source and at the back of the Gas-Purging PlateLoc.

CAUTION
Do not connect the argon tubing to the air-input (AIR IN) port. Doing so can cause 
errors when you operate the PlateLoc.

Figure Argon connection on Gas-Purging PlateLoc (rear view)
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Checking the argon connections

To check the argon connection:
1 With the PlateLoc Sealer turned off, gently tug the argon tubing at each connection.

If you feel resistance at the connection, the tubing has been properly installed.
2 Turn on the argon source.
3 Listen near each connection for hissing sounds that might indicate a leak.

If you hear hissing sounds, turn off the argon at the source, at the inline shutoff 
valve, and on the back of the PlateLoc. Check and tighten the connections, and then 
turn on the argon again. If the problem persists, contact your facilities department 
or Agilent Technical Support.

Disconnecting the argon source

CAUTION
Pulling the tubing out of the orange quick-release fitting can damage the fitting. To 
disconnect the tubing, ensure that you use the following procedure.

To disconnect the argon tubing from the Gas-Purging PlateLoc:
1 Turn off the argon at the source (house or cylinder) and at the inline shutoff valve.
2 Push and hold the locking collar against the fitting, and then gently pull the argon 

tubing out.

Figure Quick-disconnect fitting

Note: Alternatively, you can use the SMC Pneumatics tool (TG-2) to aid in this 
task. See the manufacturer’s documentation for use instructions. Contact your 
local SMC parts supplier for ordering details.

Related information

For information about... See...

Installing the PlateLoc Sealer “Installation workflow” on page 24

Safety guidelines “Safety guidelines” on page 1

Connecting the air source “Connecting and disconnecting the air 
source” on page 34
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Setting up the computer (lab automation system only)

About this topic

Read this topic if you are integrating a PlateLoc Sealer in a lab automation system. 
Note: To operate the PlateLoc Sealer as a standalone device, you can use the 
touchscreen. A computer is not required.

Before you start

Make sure you have the serial cable.

Connecting to the controlling computer

To connect the PlateLoc Sealer to the controlling computer:
1 Turn off the controlling computer.
2 Connect one end of the serial communications cable to a serial communications 

port on the controlling computer.
Make a note of the COM port number. You will provide the number when creating a 
device profile in the diagnostics software. 
Note: You can use the Microsoft Windows Device Manager to determine the 
COM port number. For instructions, see the Microsoft Windows 
documentation.

3 Connect the free end of the serial cable to the back of the PlateLoc Sealer.

Figure Serial connector on rear panel

About installing the VWorks software

If you are integrating the PlateLoc Sealer in a lab automation system that uses VWorks 
Automation Control, the software must be installed on the controlling computer. The 
VWorks software includes PlateLoc Diagnostics, which enables you to create device 
profiles and control the device for diagnostic purposes. 
For VWorks installation instructions, see the VWorks software release notes. 
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IMPORTANT
Do not install the VWorks software if you are planning to use the PlateLoc ActiveX 
controls to interface with the PlateLoc Sealer. The PlateLoc ActiveX controls can 
conflict with the PlateLoc plugin.

About the PlateLoc ActiveX in a third-party lab automation system

In an automation system that uses third-party automation control software, you use the 
PlateLoc ActiveX controls to permit the software to interface with the PlateLoc Sealer. 

To install the PlateLoc ActiveX software:
1 Insert the provided CD into the controlling computer CDROM drive.
2 In the CD folder, double-click setup.exe.
3 Follow the instructions in the installation wizard window. Be sure to select the 

Complete setup option.

Related information

For information about... See...

About lab automation software “Software overview” on page 19

Computer requirements VWorks release notes

Using ActiveX controls to interface 
with the PlateLoc

PlateLoc Sealer ActiveX version 13.0 User 
Guide
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4 Getting started
This chapter contains the following topics:
• “Turning on and off the power” on page 42
• “Turning on and off the air” on page 43
• “Turning on and turning off the argon (Gas-Purging Plateloc only)” on page 45
• “Tilting or stowing the touchscreen” on page 47
• “Adjusting the touchscreen brightness” on page 49
• “Specifying a Sleep Mode” on page 50
• “Loading and unloading a roll of seal” on page 51
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Turning on and off the power

Turning on the PlateLoc Sealer

Figure PlateLoc Sealer on/off switch (rear view)

To turn on the PlateLoc Sealer:
Press the on/off switch to the on position (I). 
If you have not yet turned on the air, the touchscreen displays the Insufficient Air 
Pressure error message. 

Turning off the PlateLoc Sealer

To turn off the PlateLoc Sealer:
Press the on/off switch to the off position (o). The touchscreen turns off.

Related information
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For information about... See...

Safety guidelines “Safety guidelines” on page 1

Site requirements “Laboratory requirements” on page 25

Turning on and off the air “Turning on and off the air” on page 43
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Turning on and off the air 

Before you turn on the air

Ensure the following:
• The air is turned on at the source (house, cylinder, or pump) and the air pressure 

and flow rate meet the PlateLoc requirements.
• The inline shutoff valve is turned on.
• The PlateLoc Sealer is turned on.

Turning on the air

To turn on the air:
Push the AIR ON/OFF switch to the ON position.

Figure PlateLoc Sealer AIR ON/OFF switch (rear view)

When you turn on the air, the PlateLoc Sealer door opens. The door remains open while 
the device is in idle mode, until you load a microplate.

CAUTION
Closing the PlateLoc door while the device is in idle mode will shorten the life of the 
PlateLoc Sealer. Leave the PlateLoc door open while the device is in idle mode.

IMPORTANT
If this is the first time you are turning on the air, you must remove the packing foam 
inside the sealing chamber before you can use the device.
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IMPORTANT
Save the packing foam in case you need to move or ship the PlateLoc Sealer. The 
packing foam is designed to protect the device. Packing the PlateLoc Sealer using other 
materials can damage the device and void your warranty.

Checking for air flow

To check that air is flowing into the PlateLoc Sealer:
Check the pressure gauge on the back of the PlateLoc Sealer. If air is flowing into the 
device, the gauge should show a non-zero pressure value.
If the gauge shows 0 psi, check the air tubing connections and the connections at the 
source (house, cylinder, or pump).

IMPORTANT
The pressure reading on the back of the PlateLoc Sealer might be different from the 
value shown on the touchscreen. The pressure gauge on the back of the PlateLoc 
Sealer should be used to determine the presence of air flow only. To check the air 
pressure inside of the device, view the air pressure information displayed on the 
touchscreen.

Checking the internal air pressure

To check the internal air pressure:
On the touchscreen Home page, locate the Air Pressure readout. The regulated air 
pressure should be approximately 0.599–0.62 MPa (87–90 psi).
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Turning off the air 

To turn off the air:
Push the AIR ON/OFF switch to the OFF position.

Related information

Turning on and turning off the argon (Gas-Purging Plateloc only)

About this topic

Read this topic only if you have the Gas-Purging PlateLoc.

Before turning on the argon

WARNING
Inert gases such as nitrogen and argon are odorless, colorless, and nontoxic and can 
cause rapid suffocation by displacing air. Use the inert gas only in a well-ventilated 
lab area. Turn off the inert gas sources when the product is not in use. 

Make sure that the:
• Gas-Purging PlateLoc is installed properly.
• The Gas-Purging PlateLoc is turned on.
• The argon is turned on at the source (house or cylinder) and the argon pressure 

meets the Gas-Purging PlateLoc requirements.
• The argon is turned on at the inline shutoff valve.

Turning on the argon

The Gas-Purging PlateLoc automatically turns on the argon inside the device when you 
start the seal cycle. The argon flows into the chamber from three areas, as the 
following figure shows.

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Site requirements “Laboratory requirements” on page 25

Turning on and turning off the power “Turning on and off the power” on page 42
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Figure Areas where argon flows into the sealing chamber

Checking for argon flow

You can check for argon flow using a test microplate, such as the OxoPlate (Innovative 
Instruments, Inc., www.3i-usa.com/product_oxoplate.htm) or equivalent. Test 
microplates can indicate the amount of oxygen displaced. For instructions, see the 
manufacturer’s user documentation.

Checking the internal argon pressure

You do not need to check the internal argon pressure. Make sure the argon pressure 
from your lab is 0.28 MPa (40 psi).

Turning off the argon

For safety reasons, the Gas-Purging PlateLoc automatically turns off the argon inside 
the device immediately before the seal is applied.
Agilent Technologies recommends that you turn off the argon at the source (house or 
cylinder) when the Gas-Purging PlateLoc is not in use.

Item Description

1 Argon output panel at the top of the doorway. 
Argon flows out from a row of ports across the bottom of this panel, 
producing a curtain of gas that passes across the microplate as it enters 
the sealing chamber

2 Argon output port on the interior left wall and right wall (not shown) of the 
sealing chamber. 
Argon flows into the sealing chamber from these ports before the seal is 
applied.

1

2
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Related information

Tilting or stowing the touchscreen

About this topic

This topic explains how to tilt or stow the touchscreen on the front of the PlateLoc 
Sealer.

Tilting the touchscreen

You can tilt the touchscreen to better view the contents on the screen.

To tilt the touchscreen:
1 On the right side of the PlateLoc Sealer, push down the screen-release lever (1), as 

the following figure shows.
2 Pull out the touchscreen (2) from the bottom until the screen release clicks.

                                                        

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Site requirements “Laboratory requirements” on page 25

Connecting the argon source “Connecting and disconnecting the argon 
source” on page 36
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Stowing the touchscreen

CAUTION
In a lab automation system, the robot can collide with the tilted touchscreen on the 
PlateLoc Sealer, resulting in equipment damage. Keep the touchscreen stowed in a 
lab automation system, unless you are using it to set parameters or check status.

You can stow the screen so that it is flush against the front of the PlateLoc Sealer. You 
might want to stow the screen when the PlateLoc Sealer is not in use, to prevent a lab 
automation robot from colliding into the touchscreen, or when moving or shipping the 
device.

To stow the touchscreen:
1 On the right side of the PlateLoc Sealer, push down the screen-release lever (1), as 

the preceding figure shows.
2 Push the bottom of the screen into the device until the screen release clicks. The 

touchscreen is in its stowed position.

Related information

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Hardware components “Hardware overview” on page 9

Adjusting the contrast of the 
touchscreen

“Adjusting the touchscreen brightness” on 
page 49
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Adjusting the touchscreen brightness

Procedure

To adjust the touchscreen brightness:
1 Make sure the PlateLoc Sealer is turned on.

2 On the touchscreen, press  to display the Settings pages

3 At the top of the page, press  to go to Settings page 2.

4 Next to Screen Brightness, press  to decrease or  to increase the brightness.
5 Press Save to save the new setting.

Related information

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Hardware components “Hardware overview” on page 9

Connection panel “Connection panel” on page 12
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Specifying a Sleep Mode

About Sleep Mode

The Sleep Mode specifies a period of idle time, after which the PlateLoc Sealer will 
automatically cool down. Ensure that you use the Sleep Mode when the device will be 
idle to help preserve the lifetime of the PlateLoc hotplate. 

Procedure

To specify the Sleep Mode setting:

1 On the touchscreen, press  to display the Settings pages

2 At the top of the page, press  to go to Settings page 2.

3 Next to Sleep Mode, press  or  to select one of the following:
• 20 (minutes)
• 60 (minutes)
• 300 (minutes)
• Off. Turns off the Sleep Mode.

4 Press Save to save the new setting.

Related information

For information about... See...

Turning on or off the power “Turning on and off the power” on page 42

Stopping a seal cycle “Stopping a seal cycle in progress” on 
page 81

Connection panel “Connection panel” on page 12
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Loading and unloading a roll of seal

Before you start

CAUTION
Seals from a supplier other than Agilent Technologies might not seal properly in the 
PlateLoc Sealer and can damage the device. Use only Agilent seals with the PlateLoc 
Sealer. 

IMPORTANT
The PlateLoc Sealer will not seal microplates properly if the seal is wrinkled or torn.

Ensure that you have the following:
• Appropriate seal for your application. For guidance, see the PlateLoc Thermal 

Microplate Sealer Consumables Selection Guide.
• The supplied seal-loading card.

Note: This card is included in every package of seal.

Loading the seal

To warm up or cool down the PlateLoc Sealer:

1 On the touchscreen, press  to display the Settings pages.

2 Set the Seal Temp to a value from 30 to 40 °C. 

Note: Press  or  to adjust the value down or up in 0.5 °C increments. 
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3 Press Save to save the new Seal Temp value.

4 Press  to return to the Home page. A status message appears at the top of the 
page, indicating that the PlateLoc Sealer is warming up or cooling down to the new 
set temperature.

5 Wait for the PlateLoc Sealer to warm up or cool down to the set temperature. 
The Home page displays the Ready message and the Run button is available when 
the temperature is within the set range.

To assemble a roll of seal on the axle and hubs:
1 Remove the seal roll (1), seal-roll hubs (2), and axle (3) from their packaging. See the 

following figure.
2 Screw one of the hubs onto the axle.
3 Place the axle through the hole at the center of the seal roll. Make sure the hub fits 

snugly against the roll.
4 Screw the second hub onto the axle so that the roll is firmly secured between both 

hubs.
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5 Using scissors, cut off any wrinkled or torn material from the end of the seal so that 
the end of the seal has a clean, straight edge.

CAUTION
The PlateLoc Sealer will not seal microplates properly if the seal is wrinkled or torn.

To mount the seal roll on the seal-roll supports:
1 Orient the roll, and set the assembled seal roll onto the seal-roll supports (1) as 

shown in the following figure. Notice that the end of the seal material rolls out from 
under the roll.

2 Pull the seal from under the cross-beam (2), as the following figure shows.

To insert the seal into the PlateLoc Sealer:
1 On the back of the PlateLoc Sealer, push down the red recessed open-gripper 

button until it clicks. 
Pressing the button opens the seal gripper inside the device.

00195
PlateLoc
seal roll

1

2

3
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2 Remove the strip of paper that covers the adhesive on the end of the seal-loading 
card.

3 Follow the instructions on the card to:
a Attach the end of the seal to the card.
b Insert the card into the seal entry slot on the back of the PlateLoc Sealer.
c Push the card into the PlateLoc Sealer until it protrudes beyond the chamber 

doorway at the front of the device.

d Pull the card through the PlateLoc Sealer so that the end of the seal is past the 
plate stage.

00191
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connections

00191
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4 While maintaining the alignment of the seal with the plate stage, press the silver 
close-gripper button on the back of the PlateLoc Sealer until it clicks. The red open-
gripper button pops back up.
Pressing the silver button closes the gripper and holds the seal in place inside the 
device.

5 Turn the seal roll to remove excess slack in the seal.

6 Load a plate stage on the plate-stage support.
7 Load a spare microplate on the plate stage.
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8 Hold the seal-loading card at the touchscreen level, keeping the tension on the card.

9 On the touchscreen Home page , press Run. Continue to keep the tension on 
the card as the seal feeds through the PlateLoc Sealer.
The purpose of this seal cycle is to cut the seal and prepare it for use. The seal is 
not applied to the spare microplate.

10 If an error displays on the touchscreen, press Clear to clear the error. Press Run 
again to make sure that the seal will apply to the spare microplate. 

 

Unloading a roll of seal

To unload a roll of seal:
1 Power cycle the PlateLoc Sealer by turning off and turning on the device.

Power cycling resets the components inside the device and removes the hold on 
the seal.

2 On the back of the PlateLoc Sealer, push down the red recessed gripper-release 
button until it clicks.
Pressing the button opens the seal gripper inside the device.

3 Pull the seal out of the slot.
4 Lift the seal roll off of the seal-roll supports.
5 Unscrew one hub from the axle.
6 Remove the roll from the axle.
 

Related information

00191
PlateLoc
connections

00191
PlateLoc
connections

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Hardware components “Hardware overview” on page 9

Connection panel “Connection panel” on page 12

Seal Clearing Mode “Clearing jammed seal” on page 92
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5 Setting up for automation software 
control
This chapter describes how to set up the PlateLoc Sealer when the device is 
integrated in a lab automation system and under software control.
The topics are:
• “Setup workflow for automation software control” on page 58
• “Creating and editing VWorks device files” on page 59
• “Opening PlateLoc Diagnostics” on page 62
• “Creating and editing profiles” on page 64
• “Initializing the device” on page 67
Note: You do not need to read the topics in this section if you have a standalone 
PlateLoc Sealer.
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Setup workflow for automation software control

About this topic

Note: You do not need to read the topics in this section if you have a standalone 
PlateLoc Sealer.

Workflow

If you are setting up the PlateLoc Sealer for the first time, perform the following steps to 
establish communication between the computer and the device.

Step Procedure See...

1 Add the PlateLoc device to a 
device file.

“Creating and editing VWorks device files” 
on page 59

2 Open the PlateLoc Diagnostics 
software.

“Opening PlateLoc Diagnostics” on 
page 62

3 Create a device profile. “Creating and editing profiles” on page 64

4 Initialize the device profile. “Initializing the device” on page 67
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Creating and editing VWorks device files

About this topic

Read this topic if you are integrating the PlateLoc Sealer in a lab automation system 
that uses the VWorks software. This topic explains how to add the PlateLoc device to a 
VWorks device file and how to edit the device properties. 

Devices and device file defined

What is a device?
A device is an item in your lab automation system that has an entry in the VWorks 
software device file. A device can be a robot, an instrument, or a location in the system 
that can hold a piece of labware. 

What is a device file?
To communicate with and to control the robot and integrated devices, the VWorks 
software uses a device file that contains the following information:
• List of devices the software will communicate with and control
• Profile of each device (communication method, unique device configuration 

information)
• System-related configuration information of each device (for example, approach 

height, barcode access, and so on)
You provide the device information in the VWorks software. The device information is 
stored in a device (.dev) file that is located in a folder you specify when saving the file.

Adding the PlateLoc device to a device file

For instruction on how to log in to the VWorks software, see the VWorks Automation 
Control User Guide for instructions.

To add the PlateLoc device to a device file:
1 In the VWorks window, open the device file or create a new device file.

• To create a device file, click File > New > Device. A Device File tab appears. 
Select File > Save to save the device file. 

• To open a device file, click File >Open. In the Open dialog box, select Device Files 
(.dev files) as the file type, select the <name>.dev file, and click Open.

2 In the Available Devices area, double-click the Agilent PlateLoc device icon.
Alternatively, you can drag the icon from the Available Devices area into the Device 
File area.
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Figure PlateLoc device in the VWorks window 

Notice that in the Devices area, the first PlateLoc device is labeled PlateLoc-1. If you 
add another PlateLoc device, it will appear as PlateLoc-2.
Note: If you do not see the PlateLoc in the Available Devices list, check that the 
plugin file (AgilentPlateLoc.dll) is stored in the following folder: 
C:\Program Files (x86)\Agilent Technologies\VWorks\Plugins\
If you have added the PlateLoc plugin file in the Plugins folder and started the 
VWorks software, and still do not see the PlateLoc in the Available Devices list, 
close any open device files and protocol files, and then select Tools > Reload 
Plugins.

Setting the PlateLoc device properties

To set the PlateLoc properties:
1 In the PlateLoc Properties area of the device file, type or select the following:

2 In the Devices area, expand PlateLoc, and then select Stage.
3 In the PlateLoc Location Properties area, set the following parameters:

Property Description
Name The name of the PlateLoc.
Profile The profile associated with the device.

Select the desired profile from the list. If the profile you 
want does not appear in the list, or if no profile appears in 
the list, see “Creating and editing profiles” on page 64, 
and then return to this step to select the profile.

IMPORTANT Without the profile, you will not be able 
to establish communication with the device.
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4 Select File > Save to save the device file.

Related information

Parameter Description
Allow/prohibited 
labware

Permitted labware class for the selected location.
Use this field only if you want to limit the labware types. 
For details on labware classes, see the VWorks 
Automation Control Setup Guide.

BCR on south/west/
north/east side

The location of the barcode reader and the desired 
barcode reader device.
Use this field only if a barcode reader is installed on the 
device.

Use for deadlock 
avoidance

The option to permit the location to be used for deadlock 
avoidance.
Select Yes to permit labware to be moved to this location 
to avoid a deadlock in the system.
Select No if you do not want to move random labware to 
this location to avoid deadlock.

IMPORTANT For typical operation, select Yes for the 
PlateLoc.

Door Not applicable

For information about... See...

Opening the diagnostics software “Opening PlateLoc Diagnostics” on page 62

Creating a device profile “Creating and editing profiles” on page 64

Initializing the device profile “Initializing the device” on page 67
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Opening PlateLoc Diagnostics 

About this topic

Read this topic if your PlateLoc Sealer is integrated with automation control software.
The PlateLoc Diagnostics software enables you to create device profiles and control the 
motions of the PlateLoc Sealer. The way you access PlateLoc Diagnostics depends on 
the automation control software that you are using:
• “Opening Diagnostics from the VWorks software” on page 62
• “Opening Diagnostics from third-party software” on page 64

Opening Diagnostics from the VWorks software

To open PlateLoc Diagnostics:
1 In the VWorks window, ensure that the device file is open.

To open the device file, choose File > Open. In the Open dialog box, select the *.dev 
file type, navigate to the device file, and then click Open.
A list of the devices appears in the Device File tab.

2 Select the Agilent PlateLoc device, and then click Device diagnostics.

The PlateLoc Diagnostics dialog box opens with the Profiles tab displayed.
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The PlateLoc Diagnostics dialog box contains two tabs:
• Profiles tab. Enables you to create and manage PlateLoc profiles, specify default 

parameter values, and establish communication between the PlateLoc Sealer and 
the computer.

• Controls tab. Provides tools to help you diagnose problems with the PlateLoc 
Sealer. You can set sealing parameters, perform a seal cycle, and view status 
indicators.
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Opening Diagnostics from third-party software

If you are using third-party automation software, call the ShowDiagsDialog method to 
open PlateLoc Diagnostics. For details, see the PlateLoc Sealer ActiveX version 13.0 
User Guide.

Related information

Creating and editing profiles 

About this topic

Read this topic if your PlateLoc Sealer is integrated with automation control software. 
This topic explains how to use PlateLoc Diagnostics to create a profile for the PlateLoc 
Sealer. 

About profiles

IMPORTANT
Each PlateLoc Sealer in a lab automation system requires a unique device profile.

The profile does the following:
• Specifies the communication port on the computer, which enables the lab 

automation system software to communicate with the PlateLoc Sealer.
• Allows you to specify default parameter values.
You use PlateLoc Diagnostics to create and manage the device profiles.

Creating profiles

To create profiles for the PlateLoc:
1 Open the PlateLoc Diagnostics dialog box. For details, see “Opening PlateLoc 

Diagnostics” on page 62.
2 In the Profiles tab, click Create a new profile.

For information about... See...

PlateLoc ActiveX controls PlateLoc Sealer ActiveX version 13.0 User Guide

Creating a profile “Creating and editing profiles” on page 64

Initializing a profile “Initializing the device” on page 67
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3 In the Create Profile dialog box, type a name for the new profile, and then click OK.
4 In the Profile Settings area, set the following parameters.

5 Click Update this profile to save the current selections and settings.
                                                        

Parameter Description
Communication Settings

Serial port
Select the COM port on the controlling computer 
that is connected to the PlateLoc Sealer.

Startup Values The PlateLoc Sealer defaults to these values every 
time you initialize the device.

Startup seal time 
(0.5–12 s)

Type the default sealing duration, in seconds.

Startup seal temp 
(20–200 °C)

Type the default sealing temperature, in degrees 
Celsius.

Warm-Up/Cool-Down 
Timeouts

The wait period starts when the lab automation 
software commands the PlateLoc Sealer to start 
the seal cycle.

Max warm-up wait (1–
30000 s)

Type the amount of time, in seconds, the PlateLoc 
Sealer should wait for the warm-up before it times 
out.

Max cool-down wait 
(1–30000 s)

Type the amount of time, in seconds, the PlateLoc 
Sealer should wait for the cool-down before it times 
out.
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Editing and managing profiles

In the Profiles tab, you can select an existing profile, and then rename, copy, or delete 
the profile.

To edit a profile:
1 In the Profiles tab, select the profile you want to edit in the Profile Management area.
2 Modify the profile information.
3 When you are finished, click Update this profile to save the changes.

Related information

For information about... See...

PlateLoc ActiveX controls PlateLoc Sealer ActiveX version 13.0 User 
Guide

Opening PlateLoc Diagnostics “Opening PlateLoc Diagnostics” on page 62

Initializing a profile “Initializing the device” on page 67
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Initializing the device

About this topic

To establish communication between the computer and the PlateLoc Sealer, you 
initialize the PlateLoc device. This topic describes how to initialize the PlateLoc device 
in the following ways:
• PlateLoc Diagnostics. To control the PlateLoc Sealer using PlateLoc Diagnostics, 

initialize the profile in PlateLoc Diagnostics. 
• VWorks window. To control the PlateLoc Sealer using the VWorks software, for 

example, to run a protocol, initialize the device in the VWorks window.
For a description of the ActiveX control, see the PlateLoc Sealer ActiveX version 13.0 
User Guide.

Initializing the device in PlateLoc Diagnostics

To initialize the device in PlateLoc Diagnostics:
1 Open the PlateLoc Diagnostics dialog box.
2 In the Profiles tab, ensure that the correct profile is selected in the Profile name list.
3 Click Initialize this profile to start initializing the selected profile.
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Initializing the PlateLoc device in the VWorks software

To initialize the device from the VWorks window:
1 In the VWorks window, ensure that Simulation is off.

2 Choose File > Open. In the Open dialog box, select the *.dev file type, navigate to the 
device file, and then click Open.
A list of the devices appears in the Device File tab.

3 In the Devices area, select the PlateLoc device.
4 In the PlateLoc Properties area, make sure the correct profile is selected.
5 Click Initialize selected devices.

Related information

For information about... See...

PlateLoc ActiveX controls PlateLoc Sealer ActiveX version 13.0 User 
Guide

VWorks software VWorks Automation Control User Guide

Opening PlateLoc Diagnostics “Opening PlateLoc Diagnostics” on page 62

Creating a profile “Creating and editing profiles” on page 64
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6 Sealing microplates
This chapter contains the following topics:
• “Loading an insert and a microplate” on page 70
• “Setting the sealing parameters” on page 72
• “Starting the seal cycle” on page 78
• “Stopping a seal cycle in progress” on page 81
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Loading an insert and a microplate

About this topic

This topic explains how to load a microplate in the PlateLoc Sealer.

Before you start

                                                        

Step For this task... See...

1 Turn on the PlateLoc Sealer. “Turning on and off the power” on page 42

2 Turn on the air and ensure that the PlateLoc 
door is open.

“Turning on and off the air” on page 43

3 Gas-Purging PlateLoc only. Ensure the argon 
source (house or cylinder) is turned on.

“Turning on and turning off the argon (Gas-Purging 
Plateloc only)” on page 45

4 Ensure the seal is properly loaded. “Loading and unloading a roll of seal” on page 51

5 Lab automation systems only. Initialize the 
PlateLoc Sealer.

“Initializing the device” on page 67

6 Verify the sealing parameters are set correctly. • Standalone device. “Setting the sealing 
parameters” on page 72.

• Integrated device. VWorks Automation Control 
User Guide or third-party software 
documentation.

7 Verify that the PlateLoc Sealer is warmed up or 
cooled down to the sealing temperature.

–
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Standalone device procedure

To load a microplate and an insert in the standalone device:
1 Place the removable plate stage (1a) on the plate-stage support (1b), as the 

following figure shows.
2 Optional. Place the insert (2) on the plate stage.
3 Place the microplate (3) on the insert or plate stage. Make sure the microplate is 

level and the microplate skirt is within the raised tabs on the plate stage.

 

Lab automation system procedure

If the PlateLoc Sealer is installed in a lab automation system, make sure that you load 
the appropriate microplate insert before you start the protocol run. For guidelines on 
choosing an insert, see “Inserts for microplate support” on page 16.
During the run, the robot loads the microplates automatically. You do not need to 
manually load each microplate.

Related information
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plate insert
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For information about... See...

Microplate requirements “Labware considerations” on page 13

Using an insert for uniform seals “Inserts for microplate support” on page 16
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Setting the sealing parameters

About this topic

This topic describes how to set the sealing parameters:
• “Using the touchscreen to set sealing parameters” on page 74
• “Selecting and editing a saved method (touchscreen)” on page 75
• “About using lab automation software to set parameters” on page 77
Note: To use PlateLoc Diagnostics to perform a seal cycle, see “Using diagnostic tools” 
on page 100.

Before you start

To prepare for a seal cycle, ensure the following:

                                                        

Seal optimization guidelines “Optimization test guidelines” on page 84

For information about... See...

Step Procedure See...

1 The PlateLoc Sealer is turned on. “Turning on and off the power” on page 42

2 The air is turned on. “Turning on and off the air” on page 43

3 The seal is properly loaded. “Loading and unloading a roll of seal” on 
page 51

4 Lab automation systems only. 
Communication between the 
controlling computer and the 
PlateLoc Sealer is established.

“Initializing the device” on page 67
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Settings to use as a starting point

The seal time and temperature settings depend on the type of microplate and seal that 
you are using. Generally, the shortest seal time and lowest temperature provide the 
best results. However, you should perform seal optimization tests to determine the 
optimal seal time and temperature settings. For general optimization guidelines, see 
“Optimization test guidelines” on page 84.
The following table lists guidelines that you can use as a starting point. For the most 
up-to-date recommendations, see the PlateLoc Thermal Plate Sealer Seal Selection 
Guide. 

CAUTION
Seals from a supplier other than Agilent Technologies might not seal properly in the 
PlateLoc Sealer and can damage the device. Use only Agilent seals with the PlateLoc 
Sealer. 

Note: These recommended settings are available as presets on the Preset page. For 
instructions on how to select a preset, see “Selecting and editing a saved method 
(touchscreen)” on page 75. 
                                                        

Agilent seal Microplate type

Cyclic olefin 
copolymer 

Polypropylene Polystyrene

Peelable Aluminum 190 °C, 2.5 sec 170 °C, 1.2 sec 185°C; 1.2 sec

Peelable Aluminum RT 185 °C, 1.5 sec 175 °C, 1.5 sec Not compatible

Pierceable Aluminum – 170 °C, 1.2 sec No data available

Clear Peelable Seal – 110 °C, 1–1.2 sec No data available

Clear Pierceable Thin Seal – 110 °C, 1–1.2 sec No data available

Clear Permanent Seal – 175 °C, 1.2–2 sec –
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Using the touchscreen to set sealing parameters

When the PlateLoc Sealer is operated as a standalone device, you use the touchscreen 
to set the sealing parameters 

To set the sealing parameters on the touchscreen:

1 Press  to display the Settings pages.

2 In the Settings 1/5 page, set the following values:
• Seal Time. The duration (seconds) that the hot plate will be in contact with the 

seal material and microplate.
• Seal Temp. The hot plate temperature (°C) when the seal cycle starts.
• Gas Purge Time. Gas-Purging PlateLocs only. The amount of time (seconds) the 

microplate will be exposed to argon before the microplate is sealed.

Press  or  to change the value for the corresponding setting.
3 Press Save to save the new settings. 

The touchscreen automatically returns to the  Home page. Status messages 
appear at the top of the Home page, such as, Warming up, Cooling down, or Ready.
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You can also monitor the following:
• Seal Time displays the time remaining in the seal cycle.
• Seal Temp displays the current temperature. The text turns blue when the hot 

plate temperature is within Set Temp run temperature range.
Note: The touchscreen readout displays the temperature as measured on 
the opposite side of the hot plate sealing surface. The actual temperature 
of the sealing surface may vary slightly. 

 

Selecting and editing a saved method (touchscreen)

The Preset page stores saved settings as presets. By default, the recommended 
settings for different seal and microplate types are stored in Presets 01–06. For details 
on these settings, see “Settings to use as a starting point” on page 73.

To select and edit a saved plate sealing method:

1 On the touchscreen, press  to display the Preset page.

2 Press  or  to move the highlight to the desired Preset row, and then do one 
of the following:
• To use the highlighted Preset without changing it, press Select. The selected 

values are loaded to settings on the Home page.
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Status messages appear at the top of the Home page, such as, Warming up, 
Cooling down, or Ready.

• To edit the highlighted Preset, press Edit, and then proceed to step 3.
3 In the Preset edit page, set the following:

• Seal Time. The duration (seconds) that the hot plate will be in contact with the 
seal material and microplate.

• Seal Temp. The hot plate temperature (°C) when the seal cycle starts.
• Gas Purge Time. Gas-Purging PlateLocs only. The amount of time (seconds) the 

microplate will be exposed to argon before the microplate is sealed.

Press  or  to change the value for the corresponding setting.

4 Click Save to save the edits for the Preset.
5 To load the values for the edited Preset, highlight the corresponding Preset row on 

the Preset page, and then press Select.

The Home page displays the selected preset. Status messages appear at the top of 
the Home page, such as, Warming up, Cooling down, or Ready.
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About using lab automation software to set parameters

In the VWorks software, you set the sealing parameters when you set the Seal 
(PlateLoc) task properties. For details, see the VWorks Automation Control User Guide.
If the PlateLoc Sealer is integrated with third-party software, see the PlateLoc Sealer 
ActiveX version 13.0 User Guide.

Related information

For information about... See...

Guidelines on seal time and 
temperature parameters

 PlateLoc Thermal Plate Sealer Seal 
Selection Guide

Microplate requirements “Labware considerations” on page 13

Using an insert for uniform seals “Inserts for microplate support” on page 16
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Starting the seal cycle

About this topic

This topic explains how to seal a microplate using the PlateLoc Sealer touchscreen or in 
an Agilent lab automation system.
Note: To use PlateLoc Diagnostics to perform a seal cycle, see “Using diagnostic tools” 
on page 100.

Before you start

Ensure that the following steps have been performed:

                                                        

Step Procedure See...

1 The PlateLoc Sealer is turned on. “Turning on and off the power” on page 42

2 The air is turned on and the 
internal air pressure is within the 
recommended range.

“Turning on and off the air” on page 43

3 Gas-Purging PlateLoc only. The 
argon source (house or cylinder) 
is turned on.

“Turning on and turning off the argon 
(Gas-Purging Plateloc only)” on page 45

4 The seal is properly loaded. “Loading and unloading a roll of seal” on 
page 51

5 Lab automation systems only. 
Communication between the 
controlling computer and the 
PlateLoc Sealer is established.

“Initializing the device” on page 67

6 The sealing parameters are set 
correctly.

“Setting the sealing parameters” on 
page 72

7 Standalone PlateLoc only. The 
microplate is loaded.

“Loading an insert and a microplate” on 
page 70
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Using the touchscreen to start the seal cycle 

To use the touchscreen to start the seal cycle:

1 If not already displayed, press  to go to the Home page.

2 Verify the following:
• The correct values are specified for Set Time and Set Temp. 
• At the top of the page, the status bar displays Ready. 

3 Press Run. The microplate moves into the sealing chamber and the door closes. 
The seal cycle begins. The status bar at the top of the touchscreen displays In 
Progress.

Gas-Purging PlateLoc only. If the Gas Purge Time is greater than 0.0 seconds, the 
argon fills the sealing chamber for the specified amount of time before the seal is 
applied. The argon automatically turns off just before the seal is applied.
Note: If the Run button is unavailable, the PlateLoc Sealer is warming up or 
cooling down. You cannot start the seal cycle until the PlateLoc Sealer is within 
the run temperature range of the specified Set Temp.
Note: If an error occurs during the seal cycle, the cycle is aborted.

After the seal cycle is finished:
When the seal cycle is finished, the Status message changes to Ready. The door 
opens. The microplate moves out of the sealing chamber.
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WARNING
Do not handle the microplate immediately after the seal cycle is finished. The sealed 
microplate and the insert might be hot.

Wait a few seconds, and then remove the sealed microplate and insert from the plate 
stage.
 

Lab automation system procedure

You can start one or more seal cycles when you start the protocol run in the VWorks 
software. See the VWorks Automation Control User Guide.
To start a seal cycle using third-party software, see the PlateLoc Sealer ActiveX version 
13.0 User Guide.

Related information

For information about... See...

Microplate requirements “Labware considerations” on page 13

Using an insert for uniform seals “Inserts for microplate support” on page 16

Stopping a seal cycle in progress “Stopping a seal cycle in progress” on 
page 81

Seal optimization guidelines “Optimization test guidelines” on page 84
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Stopping a seal cycle in progress

About this topic

This topic explains how to stop the PlateLoc Sealer when a seal cycle is in progress. 

Using the touchscreen to stop a seal cycle

To stop a seal cycle that is in progress:
On the Home page, press Stop.

Turning off the device to stop a seal cycle

To stop a seal cycle in an emergency:
In case the Stop button on the touchscreen does not work or is not responding fast 
enough, turn off the PlateLoc Sealer (1). The on/off switch is on the back of the device. 
Alternatively, you can disconnect the power to the PlateLoc Sealer (2).

Using lab automation software to stop a seal cycle

You can stop a seal cycle from the VWorks software. For detailed instructions, see the 
VWorks Automation Control User Guide. 
To stop a seal cycle using third-party software, see the PlateLoc Sealer ActiveX version 
13.0 User Guide.
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Related information

For information about... See...

Using an insert for uniform seals “Inserts for microplate support” on page 16

Setting up the seal cycle duration and 
temperature parameters

“Setting the sealing parameters” on 
page 72

Starting a seal cycle “Starting the seal cycle” on page 78
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7 Optimizing seal quality
This chapter contains the following topics:
• “Optimization test guidelines” on page 84
• “Conducting a seal optimization test” on page 85
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Optimization test guidelines

Factors that affect seal quality

The seal quality depends on a number of factors, such as the microplate material and 
design, the type of seal you use, the need for support under the microplate, the seal 
temperature, and seal-cycle duration.
Before you start to seal microplates, make sure you run optimization tests to determine 
the following:
• The best seal to use
• The best insert to use
• The optimal sealing temperature
• The optimal seal cycle duration

Test guidelines 

When you plan optimization tests, consider the following:
• Run an optimization test for each type of microplate material and design. 

Microplates made from the same material but with different designs can require 
different sealing parameters.

• Use spare microplates in the optimization tests.
• Use a new microplate for each seal cycle. The characteristics of a microplate can 

change through repeated seal cycles, therefore changing the seal results.
• Consider the microplate content and fluid level in the wells.
• Consider the downstream application. For example, microplates used in a thermal 

cycler will require different sealing parameters than microplates placed in the 
freezer.

• Consider the downstream uses of the microplate. For example, microplates that 
will be sealed one time and discarded can have a more permanent seal than a 
microplate that will be reused and resealed repeatedly before being discarded.

• Start an optimization test with a low-temperature and short-duration setting. Adjust 
the parameters in small increments.

• Check the quality of the seal after each seal cycle to determine which sealing 
parameters to adjust and whether the microplate requires an insert for support.

• Record the optimal sealing parameters.

Related information

For information about... See...

Seal optimization tests “Conducting a seal optimization test” on 
page 85

Seal selection, insert selection, and 
other optimization guidelines

 PlateLoc Thermal Plate Sealer Seal 
Selection Guide

Microplate guidelines “Labware considerations” on page 13
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Conducting a seal optimization test

About this topic

This topic explains how to check the seal quality to determine how to adjust the sealing 
parameters.

Workflow

Using an insert for uniform seals “Inserts for microplate support” on page 16

Setting up the seal cycle duration and 
temperature parameters

“Setting the sealing parameters” on 
page 72

For information about... See...

Step For this task... See...

1 If applicable, determine the type of insert 
required for your microplate type.

• “Labware considerations” 
on page 13

• “Inserts for microplate 
support” on page 16

2 Determine the recommended time and 
temperature parameters for your chosen 
seal and microplate material.
Note: In general, you should start by using 
the lowest temperature possible for the 
shortest time for your seal type and 
microplate material.

PlateLoc Thermal Plate Sealer 
Seal Selection Guide

3 Apply a seal using the recommended time 
and temperature parameters. 

• “Setting the sealing 
parameters” on page 72

• “Starting the seal cycle” on 
page 78

4 Evaluate the seal quality by examining the 
well impressions made on the seal.
Note: The pattern and quality of these 
impressions is a good indicator of seal 
quality.

“Evaluating the seal quality” on 
page 86

5 Make any required adjustments to the 
parameter settings, and then repeat step 2 
to step 4.
Repeat this process until you have 
optimized the parameters for your 
application.

“Setting the sealing 
parameters” on page 72
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Evaluating the seal quality

WARNING
Do not handle the microplate immediately after the seal cycle is finished. The sealed 
microplate might be hot and the hot surface can cause burn injury.

To check the seal quality:
1 After the seal cycle is finished, wait for the sealed microplate to cool down enough 

so that it is safe for handling (10 to 30 seconds).
Note: Pierceable seals might permanently adhere to the microplate. Do not wait 
too long or the seals will be difficult to remove.

2 Remove the microplate from the PlateLoc Sealer.
3 Carefully, peel off the seal material by lifting one of the corners of the seal, as the 

following figure shows.

Figure Removing the seal

If the pattern in the center of the seal differs from the pattern around the edges, an 
adjustment in the microplate insert size might be required. See “Effect of insert 
thickness on seal quality” on page 87.

4 Inspect the underside of the removed seal material and study the well impressions 
left on the seal.
If the impression of each well is unbroken on the underside of the seal material, the 
microplate was properly sealed.

Figure Example of a good seal showing detail of well impression
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5 Look closely at a single sample well to determine if the well impression matches 
the thickness and shape of the well walls.
Use a magnifying glass or inspection microscope, if necessary, to see the area 
surrounding the sample well rim.
The following figures show examples of well impressions that indicate seal quality:
• Good seal. The well impression should match the shape and thickness of the 

chimney walls, such as examples A and D.
• Poor seal caused by insufficient heat. If the well impression has faint or broken 

segments, such as examples B and C, insufficient heat may have been applied 
to form a complete impression of the sample well rim. Try increasing the 
sealing temperature or time (duration). 

• Poor seal caused by too much heat. If the well impression is significantly 
thicker than the chimney wall, such as example E, decrease the sealing 
temperature or duration. Thick impressions may indicate excessive melting of 
the seal, causing the seal to be difficult to remove and reducing the ability to 
reseal the microplate.

Figure Examples of well impressions: (A) Good seal, (B) Missing segment, and (C) Faint 
segment

Figure Examples of the well rim width in the seal (D) Good impression with thin, defined 
chimney edge, and (E) Poor impression that is thicker than the chimney wall

Effect of insert thickness on seal quality

The following figure shows a side view of a microplate with inserts of different 
thicknesses and the table describes the resulting seal quality.

A B C

D E
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Figure Effect of insert thickness on seal quality: (A) Too thin, (B) Correct, and (C) Too thick

Related information

A B C

Item Insert 
thickness 

Seal quality

A Too thin The center of the microplate bends downward during sealing, 
leading to good sealing around the edges, but poor sealing in 
the middle of the microplate.

B Correct The entire microplate surface is sealed uniformly. 

C Too thick The edges of the microplate bends downward during sealing, 
resulting in good sealing in the middle of the microplate, but 
poor sealing around the edges.

For information about... See...

Seal selection, insert selection, and 
other optimization test guidelines

 PlateLoc Thermal Plate Sealer Seal 
Selection Guide

Microplate guidelines “Labware considerations” on page 13

Using an insert for uniform seals “Inserts for microplate support” on page 16

Setting up the seal cycle duration and 
temperature parameters

“Setting the sealing parameters” on 
page 72

Starting a seal cycle “Starting the seal cycle” on page 78
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8 Maintenance and troubleshooting
This chapter provides instructions for the routine maintenance and care of the 
PlateLoc Sealer. 
The topics are:
• “Routine maintenance” on page 90
• “Viewing the vacuum readings” on page 91
• “Clearing jammed seal” on page 92
• “Cleaning the hot plate” on page 94
• “Cleaning the touchscreen” on page 98
• “Changing a fuse” on page 99
• “Using diagnostic tools” on page 100
• “Troubleshooting hardware problems” on page 102
• “Troubleshooting error messages” on page 104
• “Reporting problems” on page 107
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Routine maintenance

About this topic

This topic provides guidelines for periodic routine maintenance that you should 
perform. 
Preventive maintenance is an important part of keeping the PlateLoc Sealer running 
smoothly and error free. To schedule the annual preventive maintenance service, 
contact Agilent Technical Support.

IMPORTANT
You can specify a Sleep Mode for device idle times to help preserve the lifetime of the 
PlateLoc hotplate. For details, see “Specifying a Sleep Mode” on page 50.

Routine inspection and maintenance

Periodically, perform the routine maintenance listed below. Your schedule might vary 
depending on the frequency of use.

Maintenance task Schedule Comments

Turn off the PlateLoc power and 
air supply when the device will 
be idle for 8 hours or more.
Alternatively, set the Sleep Mode 
to turn off the device heaters at 
a specified time.

Nightly Extended exposure to high heat 
will shorten the life of the device 
internal components.
See “Specifying a Sleep Mode” 
on page 50.

Inspect the PlateLoc air line. Monthly Ensure that the tubing is in good 
condition and no air leaks are 
audible.

Clean the hot plate. Periodically The hot plate should be clean to 
ensure seal quality.
See “Cleaning the hot plate” on 
page 94.

Clean the touchscreen. Periodically Clean as needed.
See “Cleaning the touchscreen” 
on page 98.
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Viewing the vacuum readings

About the vacuum readings

The Home page can display vacuum pressure readings (inHg) for the following 
PlateLoc components:
• Gripper (Gr)
• Slider plate (Sl)
• Hot plate (Ht)
The following figure shows an example of the Vacuum Readings (3 values).

Displaying the vacuum readings on the Home page

To display the vacuum readings on the Home page:

1 On the touchscreen, press  to display the Settings pages

2 At the top of the page, press  to go to Settings 3/5.

3 Next to View Vacuum Readings, press  or  to turn Off or On this feature:
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Related information

Clearing jammed seal

About this topic

This topic describes how to use the Seal Clearing Mode to try to automatically clear 
seal that is jammed or stuck in the PlateLoc Sealer. You can repeat the following 
procedure as required to clear the seal.

CAUTION
Attempting to remove stuck seal by force will result in broken pieces of seal inside 
the device, which will cause errors. Use the Seal Clearing Mode to remove the stuck 
seal.

Procedure

If the PlateLoc temperature is greater than 45 °C, the Seal Clearing Mode will 
automatically lower the temperature before performing the seal clearing operation. 

To use the Seal Clearing Mode:
1 Make sure the PlateLoc Sealer is turned on and the air is on.
2 Gas-Purging PlateLocs only. Turn off the argon source (house or cylinder).

3 On the touchscreen, press  to display the Settings pages.

4 At the top of the page, press  to go to Settings 5/5 Seal Clearing Mode, and press 
Start.

For information about... See...

Troubleshooting problems “Troubleshooting hardware problems” on 
page 102
“Troubleshooting error messages” on 
page 104
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If the PlateLoc Sealer temperature is greater than 45 °C, the Cooling Down 
message displays at the top of the touchscreen. 

5 When the Ready message displays, press Clear Seal.

6 Follow the instructions on the touchscreen to:
a Press the recessed open-gripper button on the back of the PlateLoc Sealer.

Press down on the button until it clicks to open the seal gripper inside the 
device.
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b Roll the spool to remove seal from the seal-entry slot.
c Press Exit on the touchscreen.
d Cut off tattered or folded edges and then reload the seal. See “Loading and 

unloading a roll of seal” on page 51.

Related information

Cleaning the hot plate

About this topic

This topic explains how to clean the hot plate inside the PlateLoc Sealer. Although the 
hot plate is coated with non-stick material, residual seal material and dirt can collect on 
the hot plate over time and reduce seal quality. To ensure quality seals, you should 
check the hot plate and clean it if necessary.

Before you start

WARNING
The hot surfaces in the PlateLoc Sealer can cause a burn injury. Use care when 
accessing the PlateLoc interior after the device is warmed up. Do not touch the 
PlateLoc Sealer or pry open the door while it is in operation. Do not reach into the 
PlateLoc Sealer when it is warmed up to a high temperature. Do not touch the hot 
plate with your bare hands.
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For information about... See...

Turning on the PlateLoc power “Turning on and off the power” on page 42

Turning on the air “Turning on and off the air” on page 43

Setting the sealing temperature “Setting the sealing parameters” on 
page 72
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WARNING
A freshly sealed microplate might still be hot from the sealing process. To prevent 
potential injury, use caution when removing a sealed microplate from the PlateLoc 
Sealer. 

CAUTION
Using cleaning products other than those specified can damage the hot plate 
surface. Use only the specified cleaning products.

CAUTION
Excess fluid can react with and damage the hot plate coating. Do not spray the 
cleaning fluid directly onto the hot plate or any part of the PlateLoc Sealer. 

Make sure you have the following:
• Ammonia-based cleaner or a degreaser
• Isopropyl alcohol
• HotPlate Cleaning Kit (Agilent, part number G5561-67006)
• Optional. Flashlight

Figure Hot plate location on the ceiling of the chamber

Procedure

To clean the hot plate:
1 Turn on the PlateLoc Sealer.
2 Turn on the air to open the PlateLoc door.
3 Gas-Purging PlateLocs only. Turn off the argon source (house or cylinder).
4 Warm up the hot plate, as follows:

Note: Warming up the hot plate softens any seal material that may be present 
and can facilitate the cleaning process.

a On the touchscreen, press  to display the Settings 1/5 page.

b Set the Seal Temp to a value from 30 to 40 °C. 
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c Press Save to save the new Seal Temp value.

d Press  to return to the Home page. A status message appears at the top of 
the page, indicating that the PlateLoc Sealer is warming up or cooling down to 
the set temperature.

e Wait for the temperature to reach 30–40 °C.
5 Turn off the power and air-supply.
6 Remove the power cable, serial cable, and air supply hose.
7 Place the PlateLoc Sealer in a position, on its side for example, where you can see 

the hot plate clearly.
The hot plate is located on the ceiling of the chamber, as the following figure 
shows.
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Figure Front edge of hot plate in PlateLoc 

8 Clean the hot plate as follows:
Note: Use a flashlight if necessary.
a Dampen the heavy-duty dish wand (from the kit) with a small amount of the 

ammonia-based cleaner or a degreaser.
b Vigorously scrub the bottom of the hot plate surface (ceiling of chamber), 

including the corners, with the dish wand to remove residual seal material and 
dirt.

c Wipe the hot plate with an industrial wipe, included in the cleaning kit. 
d Visually inspect the hot plate to ensure that no seal material or debris remains. 
e If it is not clean, dampen the wire brush (from the kit) with the ammonia-based 

cleaner or degreaser and vigorously brush the entire surface of the hot plate, 
including the corners. 

f Wipe the hot plate with an industrial wipe dampened with isopropyl alcohol to 
remove any residue.

9 Inspect the hot plate to ensure it is clean. If residual seal or dirt remains, repeat 
step 8.

Related information

For information about... See...

Turning on the PlateLoc power “Turning on and off the power” on page 42

Turning on the air “Turning on and off the air” on page 43

Setting the sealing temperature “Setting the sealing parameters” on 
page 72
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Cleaning the touchscreen

Before you start

WARNING
The hot surfaces in the PlateLoc Sealer can cause a burn injury. Use care when 
accessing the PlateLoc interior after the device is warmed up. Do not touch the 
PlateLoc Sealer or pry open the door while it is in operation. Do not reach into the 
PlateLoc Sealer when it is warmed up to a high temperature. 

CAUTION
Any fluid that gets between the touchscreen and the and the screen frame can 
damage the device. Bleach and other cleaners can damage the touchscreen. Do not 
use bleach or other fluid cleaners on the touchscreen.

Make sure you have a clean, lint-free cloth.

Procedure

To clean the touchscreen:
1 Turn off the PlateLoc power.
2 Gently wipe the touchscreen with the lint-free cloth.
3 Inspect for small particles that might be caught between the screen and the screen 

frame. To remove excess debris from this area, contact Agilent Technical Support 
to schedule a Preventive Maintenance.

Related information

For information about... See...

Tilting and stowing the touchscreen “Tilting or stowing the touchscreen” on 
page 47

Adjusting the touchscreen contrast “Adjusting the touchscreen brightness” on 
page 49
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Changing a fuse

Before you start

WARNING
To prevent potential injury or equipment damage, disconnect the instrument power, 
air, and communication cables before performing the following procedure.

CAUTION
A blown fuse can indicate more serious problems. If the new fuse blows after 
replacement, contact Agilent Automation Solutions Technical Support.

CAUTION
Use only the specified fuse type for replacement. Using an incorrect fuse can 
damage the device.

Ensure that you have the following:
• Specified fuse (“Electrical requirements” on page 28)
• Flathead screwdriver

Procedure

To replace the fuse in the power switch:
1 Turn off the air source and power to the PlateLoc Sealer. Unplug the power cable 

from the rear panel connector.
2 At the rear panel power switch enclosure, use a small flat-head screwdriver (2.5 

mm) to pry open the tab at the top of the enclosure and open the enclosure cover.

Figure Fuse enclosure location

3 Insert the screwdriver head in the enclosure notch to dislodge the fuse cartridge. 
Slide the fuse cartridge all the way out of the enclosure.
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Figure Fuse enclosure location

4 Replace the fuse in the cartridge.
5 Slide the fuse cartridge back into the fuse enclosure.
6 Press the enclosure cover securely into the closed position.
7 Plug in the power cord at the rear panel connector.
 

Related information

Using diagnostic tools

Before you start

When running test seal cycles to diagnose problems, ensure that you use microplates 
that are new or in good condition.

About using the PlateLoc touchscreen

When diagnosing problems with the PlateLoc Sealer, you can use the functions 
available on the touchscreen menus. For a description of these controls and indicators, 
see “PlateLoc touchscreen interface” on page 110.

WARNING
Unauthorized use of the touchscreen Service menu can expose you to additional 
safety hazards and result in potential injury and equipment damage. The Service 
menu is for Agilent service personnel only.

For more information about... See...

Safety guidelines “Safety guidelines” on page 1

Troubleshooting problems “Troubleshooting hardware problems” on 
page 102

Reporting problems “Reporting problems” on page 107
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Using PlateLoc Diagnostics

You can use the functions in the PlateLoc Diagnostics Controls tab to set sealing 
parameters and monitor the seal cycle progress when diagnosing PlateLoc problems. 
Using controls in this tab is equivalent to using the functions on the touchscreen.

To access the diagnostic tools:
1 Initialize the profile in PlateLoc Diagnostics. For details, see “Initializing the device” 

on page 67.
2 Click the Controls tab.

For a description of these controls and indicators, see “PlateLoc Diagnostics controls 
and indicators” on page 119.

Related information

For information about... See...

Tilting and stowing the touchscreen “Tilting or stowing the touchscreen” on 
page 47

Using the touchscreen to set the 
sealing parameters

“Setting the sealing parameters” on 
page 72
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Troubleshooting hardware problems

Refer to the following table to resolve common errors. If your particular issue is not in 
the table, or if the recommended steps do not solve your problem, see “Reporting 
problems” on page 107.

Problem Cause Solution

The PlateLoc does not 
turn on. (The 
touchscreen back light 
does not turn on.)

Your lab does not meet the 
electrical requirements.

Make sure your lab meets the electrical 
requirements. See “Laboratory requirements” on 
page 25.

The PlateLoc Sealer is not 
connected to the power 
source.

Connect the PlateLoc Sealer to the power source. 
See “Connecting the power source” on page 33.

The fuse is blown. See “Changing a fuse” on page 99.

The touchscreen does 
not display text.

The PlateLoc Sealer is not 
connected to the power 
source.

Connect the PlateLoc Sealer to the power source. 
See “Connecting the power source” on page 33.

The PlateLoc Sealer is not 
turned on.

Turn on the PlateLoc Sealer. See “Turning on and 
off the power” on page 42.

The touchscreen contrast is 
set too low.

Adjust the touchscreen contrast setting. “Adjusting 
the touchscreen brightness” on page 49.

The touchscreen is damaged. Contact Agilent Technical Support.

A hissing sound can 
be heard.

A leak is present in the air or 
argon connections.

Check the air connections at the PlateLoc Sealer 
and the source (house, cylinder, or pump).
If applicable, check the argon connections at the 
PlateLoc Sealer and the source (house or cylinder).
For assistance, contact Agilent Technical Support.

The seal cycle does 
not start and an error 
message is displayed.

The cause of the error is 
described on the touchscreen.

See “Troubleshooting error messages” on page 104 
for possible solutions.

The seal does not 
apply to the 
microplate as well as 
it used to.

Excess seal material is stuck 
to the hot plate inside the 
sealing chamber.

Clean the hot plate. For cleaning instructions, see 
“Cleaning the hot plate” on page 94.

The sealing parameters 
require optimization.

See “Conducting a seal optimization test” on 
page 85.

The hot plate is damaged. Contact Agilent Technical Support.

The microplate is 
stuck to the heated 
metal plate (hot plate) 
inside the sealing 
chamber or tends to 
fall onto the stage 
after the seal cycle.

Excess seal material is stuck 
to the hot plate inside the 
sealing chamber.

Clean the hot plate. For cleaning instructions, see 
“Cleaning the hot plate” on page 94.
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CAUTION
Attempting to remove stuck seal by force will result in broken pieces of seal inside 
the device, which will cause errors. Use the Seal Clearing Mode to remove the stuck 
seal.

The seal cannot be 
pulled out from the 
slot on the back of the 
PlateLoc.

The seal is stuck inside the 
PlateLoc Sealer.

See “Clearing jammed seal” on page 92.
To re-insert the seal, see “Loading and unloading a 
roll of seal” on page 51.

A roll of aluminum 
seal continues to have 
slack after a seal 
cycle.

An internal air pressure 
adjustment may be required. 

Contact Agilent Technical Support.

Problem Cause Solution
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Troubleshooting error messages

This topic describes the error messages that may be displayed on the PlateLoc 
touchscreen, the causes of the errors, and ways to resolve the errors.

Figure Example of error message on the PlateLoc touchscreen

To resolve an error message:
1 Locate the error message in the following table and perform the recommended 

steps to resolve the problem.
2 Press Clear on the touchscreen. 
If your particular error is not in the table, or if the recommended steps do not solve your 
problem, see “Reporting problems” on page 107.

Error message Cause Solution

Actuator Time Out A sensor or the actuator failed. Make sure the seal material is properly loaded. 
Seal a spare microplate to make sure the 
PlateLoc Sealer is working properly before 
continuing.

The air pressure inside the 
PlateLoc Sealer has dropped below 
80 psi.

Check the following:
• Air pressure at the source (house, cylinder, or 

pump) meets the requirements. See 
“Laboratory requirements” on page 25.

• Air line and air connection is free of leaks.
• Gas-Purging PlateLoc. Check that the argon 

is not connected to the AIR IN fitting.

Cutter Not Down The seal-cutting blade inside the 
device is out of alignment.

Contact Agilent Technical Support.
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Cycle Stopped 
Manually

The operator pressed Stop to 
terminate the seal cycle in 
progress.

Remove the microplate. 
Ensure the seal is loaded properly and seal a 
spare microplate to make sure the PlateLoc 
Sealer is still working properly. 

Dirt on the Run button caused the 
cycle to stop. 

Clean the touchscreen and retry the operation. 

Door Close The door was unable to close after 
you started the seal cycle or run.

Check for obstacles (for example, under the door 
hinge) that are preventing the door from closing.

The door was opened while the 
seal cycle was in progress.

Remove the microplate and restart the seal 
cycle.

The door sensor is broken. Contact Agilent Technical Support.

Gripper Plate 
Vacuum

The gripper inside the PlateLoc 
Sealer was unable to hold the seal 
material, and the seal material 
might be jammed.

See “Clearing jammed seal” on page 92.
To re-insert the seal, see “Loading and unloading 
a roll of seal” on page 51.

When loading a roll of seal, you did 
not press the close-gripper button 
on the back of the PlateLoc Sealer 
to lock the seal in place. 

To re-insert the seal, see “Loading and unloading 
a roll of seal” on page 51.

Hot Plate Vacuum The hot plate vacuum was unable 
to hold the seal material. Small 
pieces of seal material might have 
fallen to the bottom of the sealing 
chamber.

Turn off the PlateLoc Sealer. Wait for the 
PlateLoc Sealer to cool down to room 
temperature. Open the door and check for seal 
material at the bottom of the sealing chamber. 
Seal a spare microplate. If the same error 
message is displayed, reload the seal. See 
“Loading and unloading a roll of seal” on page 51.

Excess seal material is stuck to the 
hot plate inside the sealing 
chamber.

Clean the hot plate. For cleaning instructions, see 
“Cleaning the hot plate” on page 94.

Insufficient Air 
Pressure

The air pressure inside the 
PlateLoc Sealer is below 80 psi.

Make sure the air pressure at the source (house, 
cylinder, or pump) meets the requirements. See 
“Laboratory requirements” on page 25.
If the air pressure at the source is sufficient, but 
the air pressure inside the PlateLoc Sealer is still 
too low (as shown on the touchscreen), check 
the air connection for leaks.
Gas-Purging PlateLoc. Check that the argon is not 
connected to the AIR IN fitting.

Insufficient Vacuum 
Pressure

The vacuum pressure generated by 
the air source is not sufficient to 
hold down the seal inside the 
sealing chamber.

Make a note of the vacuum readings and then 
contact Agilent Technical Support.
See “Viewing the vacuum readings” on page 91.

Error message Cause Solution
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Machine 
Overheating

The temperature of the hot plate is 
above acceptable limits.

Monitor the temperature and wait for the hot 
plate to cool down. If the temperature continues 
to rise, turn off the PlateLoc Sealer. Contact 
Agilent Technical Support.

Memory Access An error was encountered when 
accessing the memory.

Restart the PlateLoc Sealer. 

Memory 
Initialization

The PlateLoc Sealer found a 
memory error during startup and all 
parameter settings have been reset 
to the default values.

Contact Agilent Technical Support.

No Plate in Holder No microplate was detected on the 
plate stage.

Load the microplate and start the seal cycle.

Serial 
Communications

The serial communications buffer 
has been overloaded.

Contact Agilent Technical Support.

Temperature 
Sensors

The temperature sensors are 
reading conflicting values.

Restart the PlateLoc Sealer. 

Temperature 
Sensor Settings

The temperature sensors are not 
configured properly. The sensors 
are not enabled.

Contact Agilent Technical Support.

Transfer Plate 
Vacuum

The seal is not positioned correctly 
inside the PlateLoc Sealer.

Reload the seal. See “Loading and unloading a 
roll of seal” on page 51 for instructions.
If you are unable to pull the seal out, contact 
Agilent Technical Support.

Error message Cause Solution
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Reporting problems

Contacting technical support

If you find a problem with the PlateLoc Sealer, contact Agilent Technical Support. For 
contact information, go to https://www.agilent.com/en/contact-us/page.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number of the 
device ready. You can locate the serial number in two places:
• On the front of the PlateLoc Sealer, below the fully tilted touchscreen

• On the back of the device

Reporting software problems

When you contact Technical Support, make sure you provide the following:
• Short description of the problem

• Relevant software version number (for example, automation control software, 
diagnostics software, ActiveX control software, and firmware)

• Error message text (or screen capture of the error message dialog box)
• Relevant files, such as log files
                                                        

PlateLoc

https://www.agilent.com/en/contact-us/page
https://www.agilent.com/en/contact-us/page
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To find the firmware version number:
1 Turn on the PlateLoc Sealer.

2 On the touchscreen, press  to display the Settings pages.

3 Locate the Firmware version number in the lower left corner of the touchscreen.

Reporting user guide problems

If you find a problem with this user guide or have suggestions for improvement, send 
your comments in an email to documentation.automation@agilent.com.

Related information

For information about... See...

Diagnostics “Using diagnostic tools” on page 100

Potential hardware problems “Troubleshooting hardware problems” on 
page 102

Error messages “Troubleshooting error messages” on 
page 104

mailto:documentation.automation@agilent.com
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A Quick reference
This appendix provides a quick reference to the following:
• “PlateLoc touchscreen interface” on page 110
• “PlateLoc Diagnostics controls and indicators” on page 119
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PlateLoc touchscreen interface 

The section describes the following touchscreen components:
• Navigation pane
• Home page
• Settings pages
• Presets page

Navigation pane

WARNING
Using the commands in the Service pages can expose you to potential injury and 
cause equipment damage. The Service pages are for use by Agilent factory and 
service personnel only.

                                                         

Icon Description

 
Displays the Home page.

 
Displays the Settings pages, which enable you to adjust sealing 
parameters and view information about the device.

 
Displays the Preset page, which enables you to select from a list of 
saved plate-sealing methods.

 
Agilent factory and service personnel only. 
Displays a keypad that authorized Agilent personnel use to display 
the PlateLoc service pages to set up the device and troubleshoot 
problems.



111

A   Quick reference
PlateLoc touchscreen interface

G5585B PlateLoc Thermal Microplate Sealer User Guide

Home page

Control or indicator Description

Status bar Spans the top of the page and displays messages about the 
PlateLoc status. Possible values are:
• Ready. The PlateLoc is within range of the specified Set 

Temp and is ready for a run.
• Warming Up. The PlateLoc is in the process of warming 

up to the specified Set Temp.
• Cooling Down. The PlateLoc is in the process of cooling 

down to the specified Set Temp.
• In Progress. The PlateLoc is in the process of sealing a 

microplate.
• Error. The PlateLoc has encountered an error during the 

seal cycle.

Seal Time Displays the time remaining (seconds) in the current seal 
cycle.
Note: The seal time counts down when the seal cycle starts.

Set Time Displays the duration (seconds) that the hot plate will be in 
contact with the seal material and the microplate, as specified 
in the Settings pages.

Seal Temp Displays the current temperature (°C) of the hot plate.
• The text turns blue when the hot plate temperature is 

within the Set Temp run temperature range.
• The text is grayed when the hot plate temperature is 

above or below the Set Temp.
Note: The actual temperature of the sealing surface does not 
match the touchscreen Seal Temp readout. The touchscreen 
readout displays the temperature as measured on the 
opposite side of the hot plate sealing surface. 

Set Temp Displays the temperature (°C) setting specified in the Settings 
pages.
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Settings pages

The Settings pages include:
• Settings 1/5 — 3/5 provide controls for setting up the device
• Settings 4/5 displays information about the device
• Settings 5/5 provides controls for Seal Clearing Mode

Settings 1/5

Air Pressure Displays the device regulated air pressure (psi).
The regulated air pressure should be approximately  
0.599–0.62 MPa (87–90 psi).

Vacuum 
Readings 
(3 values)

If View Vacuum Readings is set to On in the Settings page 3/5, 
the Home page displays vacuum pressure readings (inHg) for 
the following PlateLoc components:
• Gripper (Gr)
• Slider plate (Sl)
• Hot plate (Ht)
Example of Vacuum Readings display:
Gr: 0.3/Sl: 0.3/Ht: 0.4 "Hg

RUN/STOP Starts the seal cycle or stops the seal cycle in progress.
Note: When a seal cycle is in progress, the button changes to 
STOP.

Control or indicator Description
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Control or indicator Description

Seal Time Sets the amount of time (seconds) the hot plate will be in 
contact with the sealing material and the microplate.

Press  or  to adjust the value down or up in 0.5-second 
increments.
Default: 0.5 s
Range: 0.5 to 12.0 s

Seal Temp Sets the temperature (°C) of the hot plate when the seal 
cycle starts.

Press  or  to adjust the value down or up in 0.5 °C 
increments.
Default: 20 °C
Range: 20.0 to 200.0 °C

Gas Purge Time Available for Gas-Purging PlateLoc only. Sets the amount 
of time (seconds) the microplate is exposed to argon 
before the microplate is sealed.

Press  or  to adjust the value down or up in 0.5-second 
increments.
Default: 0.5 s
Range: 0.0 to 25.0 s

Seal Counter Displays the number of sealing cycles that have occurred 
since the last time the Reset button was pressed.

Reset Resets the Seal Counter to 0.

Save Saves changes to the Seal Time, Seal Temp, and, if 
applicable, the Gas Purge Time values. 

Firmware version Displays the version of the installed firmware for the 
device.
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Settings 2/5

                                                         

Control or indicator Description

Screen Brightness Sets the brightness of the touchscreen display. As you 
reduce the brightness, the text in the touchscreen dims.

To adjust the brightness, press  or .

Sleep Mode Turns on or off the Sleep Mode. When Sleep Mode is on, 
sets the time (minutes) to wait after a seal cycle 
completes before cooling down the device when not in 
use. During Sleep Mode, the device heaters and the 
touchscreen are off.

Press  or  to select one of the following:

• 20 minutes
• 60 minutes
• 300 minutes
• Off. Turns off the Sleep Mode.
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Settings 3/5

                                                         

Indicator Description

Cycle Mode (200) Turns on or off the Cycle Mode. When set to On, the Cycle 
Mode places 200 seals on the current microplate. 
Note: This feature is typically used only by Agilent factory 
and service personnel.

Press  or  to turn On or Off this feature.

View Vacuum Readings Turns on or off the display of the vacuum pressure 
readings on the Home page.

Press  or  to turn On or Off this feature.
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Settings 4/5

 

Settings 5/5 Seal Clearing Mode

Indicator Description

Gas Purge Displays No or Yes to indicate if the device is a Gas-
Purging model.

Small Hot Plate Displays No or Yes to indicate if the device is fitted with a 
small hot plate.

Cycle Count Displays a running total of all the seal cycles that this 
device has run.

Control or indicator Description

Start Sets the PlateLoc temperature setpoint to 19 °C and cools 
the device until the temperature is 45 °C or less. 
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Presets page

For details on recommended settings, see “Settings to use as a starting point” on 
page 73.

Clear Seal Available only if the PlateLoc temperature is 45 °C or less. 
Press the button to perform the seal clearing operation. 
Repeat the Clear Seal operation as necessary to clear the 
seal.

Exit Reinstates the original temperature setpoint and displays 
the "Start" button again. 

Control or indicator Description

Control or indicator Description

Preset 01 — 10 Displays the list of saved plate sealing methods that you 
can use.
Note: By default, the recommended starting point settings 
for different seal and microplate types are stored as 
Presets 01–06. For the most up-to-date starting point 
settings, see the Seal Selection Guide. 

Edit Displays the Preset edit page where you can modify the 
seal time and temperature values for a highlighted preset.

Press  or  to highlight the desired row in the table.

Select Loads the settings of the highlighted Preset row to the 
Home page.
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Figure Example of Preset edit page 

  

Control or indicator Description

Seal Time (s) Sets the amount of time (seconds) the hot plate will be in 
contact with the sealing material and the microplate.

Press  or  to adjust the value down or up in 0.5-second 
increments.
Default: 0.5 s
Range: 0.5 to 12.0 s

Seal Temp (°C) Sets the temperature (°C) of the hot plate when the seal 
cycle starts.

Press  or  to adjust the value down or up in 0.5 °C 
increments.
Default: 20 °C
Range: 20.0 to 200.0 °C

Gas Purge Time Gas-Purging PlateLoc only. Sets the amount of time 
(seconds) the microplate is exposed to argon before the 
microplate is sealed.
Click the left or right arrow to adjust the value down or up 
in 0.5-second increments.
Default: 0.5 s
Range: 0.0 to 25.0 s

Reset Resets the Preset settings to the default values.

Save Saves the changes to the specified Preset.
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Related information

PlateLoc Diagnostics controls and indicators

Profiles tab

Profile Management area

For information about... See...

Adjusting the contrast of the 
touchscreen

“Adjusting the touchscreen brightness” on 
page 49

Seal parameters “Setting the sealing parameters” on 
page 72

Command Description

Profile name Displays the selected profile, and allows you to 
select from the list of available profiles.

Create a new profile Displays the Create Profile dialog box that enables 
you to create a new profile.

Create a copy of this profile Creates a duplicate copy of the selected profile 
with the name, Copy of <profile name>.
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Profile Settings area

Rename this profile Displays the Rename Profile dialog box that 
enables you to rename the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the device using the 
selected profile.

Parameter Description

Communication Settings
Serial port

The port that connects the controlling computer to the 
PlateLoc Sealer.

Startup Values

Startup seal time  
(0.5s – 12s)

Specifies the default sealing duration (seconds).
The PlateLoc Sealer defaults to this sealing time value 
every time you turn on the device or when you initialize 
the device.

Startup seal temp  
(20 – 200 °C)

Specifies the default sealing temperature (°C).
The PlateLoc Sealer defaults to this sealing 
temperature value every time you turn on the device or 
when you initialize the device.

Warm-Up/Cool-Down Timeouts During Protocol Execution

Max warm-up wait  
(1s – 30000s)

Specifies the amount of time (seconds) the PlateLoc 
Sealer should wait for the warm-up before it times out.
The wait period starts when you start the protocol run.

Max cool-down wait  
(1s – 30000s)

Specifies the amount of time (seconds) the PlateLoc 
Sealer should wait for the cool-down before it times 
out.
The wait period starts when you start the protocol run.

Command Description
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Controls tab

Time Settings area

Temperature Settings area

                                                        

Parameter Description

Sealing time (sec) Displays and sets the amount of time (seconds) the 
hot plate is in contact with the sealing material and the 
microplate.

Control or indicator Description

Sealing temperature (°C) Displays and sets the temperature (°C) of the 
PlateLoc hot plate when the seal cycle starts.

Actual temperature (°C) Displays the current temperature of the PlateLoc hot 
plate.
Note: The actual temperature of the sealing surface 
does not match the readout. The readout displays the 
temperature as measured on the opposite side of the 
hot plate sealing surface. 
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Status area

Execute area

Counters area

Related information

Indicator Description

Ready Indicates that the PlateLoc Sealer is within the 
specified sealing temperature range and is ready for a 
run.

Cooling down Indicates that the PlateLoc Sealer is in the process of 
cooling down to the specified sealing temperature.

Warming up Indicates that the PlateLoc Sealer is in the process of 
warming up to the specified sealing temperature.

Cycle in progress Indicates that the PlateLoc Sealer is in the process of 
sealing a microplate.

Cycle pending Indicates that the PlateLoc hot plate is warming up or 
cooling down.

In menu Indicates that another operator is setting parameters 
or using controls at the touchscreen.

Error Indicates that one or more errors have occurred.

Command Description

Start cycle Starts a seal cycle.
Note: Use the Start cycle command for sealing a 
single microplate.

Stop cycle Stops the a seal cycle in progress.

Indicator Description

Serial refresh (ms) Displays the frequency at which the controlling 
computer reads information from the PlateLoc Sealer 
and updates the status in the Controls tab.

Odometer Displays the number of seal cycles that the PlateLoc 
Sealer has performed.

For information about... See...

Creating a profile “Creating and editing profiles” on page 64

How to open PlateLoc Diagnostics “Opening PlateLoc Diagnostics” on page 62

Initializing a profile “Initializing the device” on page 67
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